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Das Erlernen von fGIS ist verhältnismässig einfach. Um alle Möglichkeiten des Programms
auszuschöpfen, braucht es jedoch Praxis. Die folgenden Kapitel führen zu den Grundlagen
von fGIS.
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Forstwirtschafts-GIS (fGIS™) ist ein Freeware-Programm für das Anzeigen, Digitalisieren
und Abfragen von GIS-Daten unter Windows®. Entworfen für Förster und Wildnisbiologen,
stellt fGIS wesentliche Werkzeuge für die Anzeige von GIS-Daten auf einem PC zur
Verfügung. Benutzen Sie fGIS zum Überlagern von verschiedenen GIS-Layern einschliesslich
Luftbildern und anderer Bilder, zum Zeichnen von Karten, zur Abfrage und zum Suchen
räumlicher Daten, zum Beschriften von Karten, für den Druck von Karten und vieles mehr.
Das Programm ist in der Grösse der zu verarbeiteten Daten unbegrenzt und erzeugt Shape-
Dateien und georeferenzierte Bilder, die mit kommerzieller GIS-Software kompatibel sind.
Förster aus Wisconsin schufen fGIS als Ergänzung zur kommerziell eingesetzten GIS-
Software. Obgleich fGIS nicht als Ersatz für diese GIS-Software geplant ist, kann fGIS völlig
ausreichend für bestimmte Anwendungen sein. Viele fGIS-Benutzer schätzen fGIS wegen
seiner kompakten Grösse und der Möglichkeit es auf einem Laptop-Computer einzusetzen.
Es ist rund um die Welt im Gebrauch, das flexible Menüsystem ermöglicht die Übersetzung
in jede mögliche Sprache.

Unterstützte Datei-Formate

Erzeugt: TatukGIS Projekt-Dateien (*.ttkgp)

Unterstützte Vektor-Formate Lesen Schreiben
ESRI® SHP Ja Ja
DXF (AutoCAD® MAP) Ja Ja
DGN (Microstation®) Ja  
DLG Ja Ja
MapInfo® MIF Ja Ja
SQL Coverages - TatukGIS Format Ja  
ESRI® e00 Ja  
TIGER2000/line Ja  
GML/XML Ja Ja

Unterstützte Raster-Formate
"Schreiben" erzeugt auch die Georeferenzdatei

Lesen Schreiben

Tiff (unkomprimiert) Ja Ja
Tiff, GeoTIFF (1, 4, 8 und 24-bit, unkomprimiert, packbits, group4, LZW) Ja  
BMP Ja Ja
Png Ja Ja
JPEG Ja Ja
ECW - ER Mapper® ECW Ja  
SID - Lizardtech® MrSID Ja  
BIL Ja  
ADF (ESRI® DEM Gitter "Arc-Data-Dateien") Ja  
WMF (ohne Georeferenzdatei)  Ja
IMG Ja  
JPEG2000 Ja  
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Sprachdateien 

fGIS enthält eine "language.ini"-Datei (eine einfache Textdatei), die für andere Sprachen als
Englisch angepasst werden kann.
Die alternativen Sprachdateien sind im Programmverzeichnis von fGIS abgelegt. Die
Erweiterung der Sprachdateien zeigt an welche Sprache sie enthalten (z.B., wird die
deutsche Sprachdatei "language.ini.de" genannt). Um eine dieser Sprachendateien zu
benutzen, benennen Sie die ursprüngliche "language.ini" um, z.B. in "language.ini.bak".
Ändern Sie dann den Namen die Sprachdatei, mit der Sie arbeiten wollen, in "language.ini".
Wenn Sie interessiert sind, selbst eine Übersetzung zu machen, finden Sie bei Jernej
Simoncic ein nützliches Software-Übersetzungswerkzeug. Es zeigt die ursprüngliche
"language.ini"-Datei im linken Fenster und die eigene Übersetzung im rechten Fenster an.
Wenn Sie eine eigene "language.ini" Datei herstellen, schicken Sie uns bitte eine Kopie.
Beachten Sie, dass der Diagram Designer von Michael Vinther auch zusätzliche Sprachen
anbietet.



  

Schneller Einstieg

1. Wenn fGIS neu startet, müssen Sie eine vorhandene Projektdatei (endet auf
"*.ttkgp") öffnen oder den Namen eines neuen Projektes eingeben.
(Anmerkung: Das "default.ttkgp" Projekt, das mit fGIS kommt, ist in Wirklichkeit
eine Wisconsin Transversal-Merkatorprojektion, welche "Willkommen zu fGIS" als
Text im Norden von Wisconsion plaziert. Es könnte Probleme verursachen, wenn Sie
Layer mit einer anderen Projektion zu diesem Projekt hinzufügen. Da fGIS dem
ersten geladenen Layer die Projektion entnimmt, ist es besser, einen neuen
Projektnamen einzugeben und Ihr neues Projekt damit zu beginnen einen Layer mit
der gewünschten Projektion hinzufügen.)

2. Drücken Sie die gelbe "+"-Taste (den Hinzufügen-Befehl) in der Werkzeugleiste
und gehen Sie zum Verzeichnis, das die Layer enthält (georeferenzierte Bilder oder
Vektordateien, die Punkte, Linien oder Flächen enthalten). Klicken Sie doppelt auf
die Datei, die Sie der Ansicht hinzufügen möchten (oder drücken Sie die Strg- (Ctrl-)
oder Umschalttasten, um mehrere Dateien auszuwählen und zu laden). Geladene
Layer müssen alle im gleichen Koordinatensystem sein, wenn sie
zusammenpassen sollen.

3. Klicken Sie doppelt auf den Layernamen, nachdem er in der Legende verzeichnet ist,
um die Layereigenschaften zugänglich zu machen und das Aussehen der Daten zu
ändern.

Als Beispiel können Sie die fGIS State_Park.zip oder Arborvitae.zip Projekte
herunterladen, um mit ihnen zu experimentieren. Um Ladezeit zu sparen, wurden niedrige
Auflösungen für die Bilder gewählt, so dass die Zip-Dateien nur Grössen von 2-3 MB
aufweisen.



Einen neuen Shape-Datei-Layer digitalisieren:

1. Verwenden Sie Datei>Neuer Layer (oder Rechtsklicken der Maus im
Darstellungsbereich und Neuer Layer). Wählen Sie entweder eine Punkt-, Linien-
oder Flächen-Shape-Datei aus, je nachdem was Sie erzeugen wollen. Beachten Sie,
bevor Sie einen neuen Layer erzeugen können, muss mindestens ein Layer
existieren (entweder Vektor- oder Rasterdaten), der in fGIS angezeigt wird, um den
Bezug zum Koordinatensystem herzustellen.

2. Geben Sie dem neuen Layer einen Namen und speichern Sie ihn.
3. Aktivieren Sie das Neue Objekt-Werkzeug (Bleistiftwerkzeug). Bestimmen Sie nun

mit der Maus Punkte im Darstellungsbereich, um das zuerfassende Objekt zu
definieren. Beachten Sie, dass Flächen im Gegenuhrzeigerrichtung zu digitalisieren
sind.

4. Rechtsklicken der Maus im Darstellungsbereich gibt Ihnen die Möglichkeit die
Datenerfassung zu beenden. Speichern Sie die Ergebnisse.

5. Klicken Sie zweimal in der Legende (Layerliste) auf den Namen des neuen Layers,
um seine Darstellungsart festzulegen.

Wenn Sie alle Änderungen vorgenommen haben, speichern Sie die fGIS-Projektdatei.
Eine fGIS-Projektdatei enthält:

• Ein Inhaltsverzeichnis des ganzen Projekts mit der Auflistung der Verzeichnisse, wo
die Daten gespeichert sind.

• Ob ein Layer eingeschaltet war (sichtbar war) als das Projekt zuletzt gespeichert
wurde.

• Die Layereigenschaften, die definiert wurden.
• Die letzte Zoomansicht.



  

Menü-Funktionen

Datei-Menü:

• Neues Projekt: Gehen Sie zum Verzeichnis wo das Projekt gespeichert werden soll.
Tippen Sie einen Namen ein und klicken Sie auf Öffnen um das Projekt anzulegen.
Projektdateien von fGIS haben eine ".ttkgp"-Dateiendung. (Dies ist die gleiche
Endung wie sie bei TatukGIS® Projekten verwendet wird, beide Produkte sind mit
dem ausgezeichneten TatukGIS-Entwicklungswerkzeug gemacht worden. Es gibt
viele Unterschiede zwischen fGIS und den einzigartigen TatukGIS® Produkten. Sie
können die TatukGIS Hilfe lesen, wenn Sie einen zusätzlichen Einblick wünschen.)

• Die Projektdateien speichern den relativen Pfad aller Dateien, die dem Projekt
hinzugefügt werden. Dieses ist nützlich, wenn Sie beschliessen, Ihr Projekt in
einer Zipdatei abzuspeichern oder auf eine CD zu brennen. Andere Benutzer
können das Projekt auf ihrem Computer leicht zu öffnen, wenn Sie die
Dateien alle in einem Verzeichnis oder in der gleichen relativen Anordnung
der Verzeichnisse miteingeschlossen haben.

• Der erste georeferenzierte Layer, den Sie dem Projekt beifügen, legt das
verwendete Koordinatensystem fest (Weltkoordinaten). Alle anderen Layer,
die einem fGIS-Projekt hinzugefügt werden, müssen im gleichen
Koordinatensystem sein, wenn sie zueinander passen sollen.

• Eine fGIS-Projektdatei enthält ein Inhaltsverzeichnis des ganzen Projekts mit



der Auflistung der Verzeichnisse, wo die Daten gespeichert sind. Weiterhin ist
vermerkt, ob ein Layer ein- oder ausgeschaltet war, als das Projekt
gespeichert wurde. Die Layereigenschaften und die letzte Zoomansicht sind
auch abgelegt.

• Öffnen Sie ein Projekt: Gehen Sie zu einer vorhandenen Projektdatei und
doppelklicken Sie auf den Namen der .ttkgp-Datei um sie zu öffnen. Das Projekt
startet mit der letzten gespeicherten Ansicht. (Sie können die .ttkgp-Datei mit fGIS
verknüpfen, so dass Projekte geöffnet werden, wenn Sie im Windows-Explorer mit
Doppelklicken die Projektdatei öffnen. Sehen Sie in der Windows®-Hilfe nach, wie
Dateiarten mit Programmen verknüpft werden.)

• Projekt speichern/Projekt speichern unter: Die gleichen Funktionen wie bei
anderen Windowsprogrammen.

• Layer hinzufügen/entfernen, Layer einschalten/ausschalten, Alle Layer in
Legende einblenden:

• Layer können mit diesen Befehlen hinzugefügt oder entfernt werden oder Sie

können die Tasten auf der Werkzeugleiste benutzen.
• Wenn Sie viele Layer in einem Projekt haben, können Sie alle Layer

ausschalten und einzelne Layer selektiv einschalten. Auf älteren Computern
wird die Ansicht schneller aufgebaut, wenn wenige Layer eingeschaltet sind.

• Alle Layer in Legende einblenden wird benutzt, um alle Layer im
Inhaltsverzeichnis (Legende) anzuzeigen. Verwenden Sie den Befehl Layer in
Legende ausblenden  im Layer-Menü, wenn die Layernamen zu viel Raum
in einer Legende einnehmen.

• Massstab einstellen: Wird gebraucht um den Massstab der Bildschirmansicht
festzulegen. Der Massstab eine gedruckten Karte wird über die Druckfunktion in der
Werkzeugleiste eingestellt.

• Attributbezogene Auswahl: Hebt alle Objekte eines Projektes hervor, die
Attributdaten enthalten, die den Suchkriterien entsprechen. Leistungsfähige
Boolesche Suchmöglichkeiten sind vorhanden.

Klicken Sie auf die Hinzufügen-Taste, um Ihre Suchkriterien in das Abfragetextfeld
zu setzen.

• Lagebezogene Auswahl: Anstatt nach Attributen zu suchen, benutzen Sie das
räumliche Auswahlwerkzeug, um Gegenstände mit einer Vielzahl von räumlichen
Parametern zu suchen. Dies Parameter umfassen folgende Liste:



• Lesezeichen: Es speichert den Mittelpunkt der Bildschirmansicht und das
Zoomniveau.

• Karteneinheiten: Die beiden Möglichkeiten sind Meter (UTM, WTM, usw..) und Fuss.
Neue Projekte werden in Meter angelegt.

• Anzeigeeinheiten: Die beiden Möglichkeiten sind Meter oder Fuss, der Massstab

wird wie folgt anzeigt:  oder 
• Auswahl: Dies erlaubt die Wahl der Farbe und Transparenz der ausgewählten

Objekte. Die Einstellungen werden in der Projektdatei gespeichert.
• Hintergrundfarbe: Der Standardeinstellung ist weiss.
• Layer indizieren: Mit dem Indexbefehl werden alle Dateien im einem Projekt

indiziert, wenn der Benutzer das Projekt speichert. Der Indexbefehl (nicht notwendig
für kleine Dateien) ist jetzt standardmässig ausgeschaltet. Er kann den Zugriff auf
grosse Datenmengen verbessern, aber er kann zu langen Pausen führen, wenn die
Indexdatei zum ersten Mal erzeugt wird.

• Übersichtskarte zeigen: Dies zeigt eine Übersichtskarte in einen neuen Fenster an.
Mit einem Rechtsklick der Maus im neuen Fenster wählen Sie den Übersichtslayer
und die Farbe des Positionsfenster aus. Das Positionsfenster zeigt die aktuelle
Position der Bildschirmansicht im Projekt an. Es kann mit der linken Maustaste
verschoben werden. Der Inhalt des Übersichtsfensters wird auch in der Projektdatei
gespeichert. Das Übersichtsfenster kann in den Druckvorlagen (tpl) benutzt werden,
um mitgedruckt zu werden.

• Order für Daten festlegen: Diese Funktion legt das Verzeichnis fest, in dem fGIS
nach zu den Projektdateien sucht.

• Neuer Layer: Erzeugt einen neuen Layern (zum Digitalisieren) im Projekt.
• Kartenansicht exportieren: Speichert die gesamte Bildschirmansicht in einer

Bilddatei (JPEG,- TIFF-, BMP- oder PNG-Format) zusammen mit einer
Georeferenzdatei. Um einen beliebigen Ausschnitt zu exportieren, benutzen Sie das
Exportwerkzeug in der Werkzeugleiste. Das Wählen der Exportoption öffnet ein
Fenster, wo Bildnamen und die Auflösung des Bildes und der Bildobjekte eingeben
können. Die Erhöhung der Bildauflösung erhöht die Bildgrösse und muss auf den
Druck abgestimmt werden. Die Erhöhung der Auflösung der Bildobjekte vergrössert
deren Darstellung im Bild.

• Legendenansicht exportieren: Speichert die Legende mit allen Symbolen als BMP-
Bilddatei.

• Karte senden an: Gestattet den Druck der Karte und den direkten Export eines
Bildes zu Word. 



Layer-Menü:

• Machen Sie sich die Layereigenschaften durch dieses Menü zugänglich oder indem
Sie den Namen eines Layers in der Layerliste doppelt anklicken.

• Auf aktiven Layer zoomen: Zeigt den vollen Umfang eines ausgewählten Layers
im Arbeitsbereich an. Die anderen Funktionen in diesem Abschnitt zoomen zu den
ausgewählten Objekten eines Layers, heben die Auswahl wieder auf, wählen das
zuletzt gewählte Objekt wieder aus und kopieren das ausgewählte Objekt in die
Zwischenablage.

• Layer nach oben/unten: Ändern Sie die Anordnung der Layer. Sie können dies
auch, indem Sie den Namen eines Layers in der Legende mit der Maus verschieben.

• Layer in Legende ausblenden: Nützlich um Raum in der Legende zu sparen
(besonders wenn Sie viele Layer geladen haben). Der Befehl Datei>Alle Layer in
Legende einblenden zeigt wieder alle Layer an.

• Layernamen ändern: Ändert den Namen eines Layers in der Legende (anstelle von
"Pfad:\Dateiname").
Anmerkung: Sie können einen Namen auch ändern, indem Sie einen Layernamen in
der Legende mit der rechten Maustaste anklicken (geht nicht im Editormodus).

• Layerdatei (.ini) speichern: Diese Funktion wird verwendet um die Anzeige-
Parameter für einen Layer zu speichern. Eine Textdatei mit der Endung ".ini" wird
dem Verzeichnis zugefügt, wo auch die Layerdaten sind. Wenn Sie den Layer einem
anderen Projekt hinzufügen, wird der Layer so angezeigt, wie er in der INI-Datei
definiert ist (wenn Sie die Eigenschaften des Layers in einem bestimmten Projekt
ändern, werden Eigenschaften von der Projektdatei anstatt von der INI-Datei
gelesen). Wenn Sie die INI-Datei in Daten einschliessen, die Sie jemand anderem
schicken, sieht er den Layer mit den Eigenschaften wie Sie ihn speicherten.

• Layerdatei (.ini) laden: Dieser Befehl ermöglicht die Layereigenschaften, die in
einer INI-Datei gespeichert sind, für einen anderen Layer zu verwenden. Benutzer
können sich eine Bibliothek von INI-Dateien erzeugen, um sie auf neue Layer
anzuwenden.

• Attributtabelle öffnen: Diese Funktion öffnet einen Datenbankeditor, der die
Attribute für alle Objekte in einer Shape-Datei anzeigt. Verwenden Sie sie, um nach
einem bestimmten Objekt mit einem bestimmten Attribut zu suchen. Das Werkzeug
ist auch für die Aktualisierung oder das Ändern von Attributwerten extrem nützlich,
wie unten dargestellt wird. Das Fenster kann auf dem ganzen Bildschirm ausgedehnt
werden, dies vereinfacht das Editieren von grossen Tabellen.
• Um einen Wert zu ändern, markieren Sie zunächst das Bearbeiten-Kästchen.

Gehen Sie dann zu dem Wert, den Sie ändern möchten und geben Sie einen
neuen Wert ein. Die Änderungen werden sofort in der Attributtabelle gespeichert.



• Wenn die Attributtabelle Felder enthält, wie sie im Folgenden aufgeführt sind,
können diese mit dem Befehl Tabelle>Shape-Datei-Messfelder aktualisieren
automatisch aktualisiert werden:

Flächen-Felder: Morgen oder Hektar
Längen- oder Perimeter-Felder: Fuss, Meilen oder Meter

Punktkoordinaten-Felder: Rechtswert oder Hochwert

Wenn die Attributtabelle nicht bereits diese Felder enthält, können diese wie folgt
hinzugefügt werden:

1. Aktivieren Sie das Bearbeiten-Kästchen.
2. Wählen Sie Tabelle>Feld hinzufügen.
3. Geben Sie einen der oben fett markierten Begriffe in das Namensfeld
ein und kennzeichnen Sie den Wert als Zahl (Typ gleich numerisch).
4. Wählen Sie Auswahl>Alles auswählen.
5. Wählen Sie nun Tabelle>Shape-Datei Messfelder aktualisieren.
Die neuen Werte werden dann ausgefüllt!

• Verwenden Sie den Einfügen-Knopf, um den Inhalt eines Feldes in den
markierten Zeilen zu ändern. Im Beispiel oben, sind alle markierten Zeilen in
"LK500" umbenannt worden.

• Verwenden Sie Auswahl>Auswahl in die Zwischenablage kopieren, um die
markierten Zeilen in die Zwischenablage zu kopieren.

• Wenn das Filtern-Kästchen markiert ist, werden nur die Werte anzeigt, die im
Textfeld sind.

• Wenn Sie bei aktiviertem Filter den Befehl Auswahl>Alles auswählen
benutzen, werden nur diese Zeilen ausgewählt. Die Befehl ist nützlich zusammen
mit dem Befehl Layerexport in Shape-Datei (siehe weiter unten).

• Die Zahl der ausgewählten Zeilen und die Gesamtzahl der Zeilen werden
ebenfalls angezeigt (nicht wenn Filtern aktiviert ist).

Zusätzliche Informationen werden unter Hilfe in der Menüleiste angezeigt.

• Raster-Bildtransparenz einstellen: Benutzer können Bereiche von
Schwarzweissbildern transparent einstellen.



• Layerexport in Shape-Datei: Diese Funktion schneidet einen Teil einer Vektordatei
aus und speichert ihn in einer neuen Shape-Datei. Der Teil, der gespeichert wird,
wird durch eine Anzahl von Parametern, einschliesslich markierten Bereichen oder
Filtern ausgewählt, die auf Fragestellungen beruhen. Die Funktion verwendet den
ausgewählten Layer in der Legende.



Editor-Menü: 

• Wenn das Editor-Menü über die Menüleiste aufgerufen wird, hat es das Aussehen,
wie oben links gezeigt, wird es über ein Rechtsklicken mit der Maustaste im
Arbeitsbereich aufgerufen, sieht es aus wie oben rechts gezeigt (einige Menüpunkte
sind grau und damit nicht verfügbar, dies ist abhängig von dem was Sie tun).
Beachten Sie, dass die fGIS-Statusleiste rot wird, wenn das Programm im
Editiermodus ist.

• Bearbeitung starten/beenden: Wenn Sie die Bearbeitung beginnen, wählen Sie
das passende Werkzeug aus der Werkzeugleiste.

• Wenn Sie ein kompliziertes Objekt digitalisieren, sich aber vertippen,
annullieren Sie die letzte Tätigkeit, um den Fehler zu beseitigen. Drücken Sie
dann die Umschalttaste (Shift), bevor Sie die richtige Position anklicken.
Digitalisieren Sie Flächen immer im Gegenuhrzeigersinn. Dieses gibt
den Punkten einer Fläche eine Numerierung im Uhrzeigersinn, was
wesentlich für den korrekten Ablauf vieler Flächenfunktionen in fGIS
ist. Wenn Sie die Numerierung links herum ist, benutzen Sie die
Drehsinnkorrektur im Flächenfunktionsmenü.

• Sie können die Attribute eines Objektes nur ändern, nur wenn Sie im
Editiermodus sind. Aktivieren Sie das Objekt mit dem Informations-Werkzeug

, um seine Attributtabelle zu öffnen. Rechtsklicken mit der Maustaste in
der linken Spalte (UID) ermöglicht das Hinzufügen, Ändern und Löschen eines
Feldes. Neue Felder werden am Ende der Liste angefügt. Zweimal klicken mit
der linken Maustaste in der rechten Spalte ermöglicht das Ändern der
Attributwerte. Klicken Sie auf OK, wenn Sie fertig sind, um Ihre Änderungen
zu speichern.

• Sie müssen "Bearbeitung beenden" wählen und Ihre Arbeit speichern,
bevor Sie Layer wechseln können oder Änderungen in der Legende
vornehmen können.

• Objekt schliessen: Manchmal wird ein Objekt beim Editieren "offen" gelassen oder
manchmal möchte der Benutzer nicht doppelklicken, um einen Prozess
abzuschliessen, benutzen Sie dann diese Option. Dieser Befehl schliesst die Arbeit ab
und ermöglicht mit dem Attributwerkzeug dem Objekt Attribute hinzuzufügen.

• Rückgängig/Wiederherstellen: Die gleichen Funktionen wie bei anderen
Windows-Programmen.

• Neues Objekt erstellen: Wählt das Digitalisierwerkzeug (Bleistift) aus und startet
die Erfassung eines neuen Objekts in fGIS.



• Objekt löschen: Löscht das ausgewählte Objekt im aktiven Layer.
• Änderungen speichern/Bearbeitung abbrechen: Die gleichen Funktionen wie bei

anderen Windows-Programmen.
• Flächenfunktionen: (für die Details, sehen Sie die

Flächenverschneidungsübungen.)

1. Bereich subtrahieren: Bereiche der aktiven Fläche, die andere Flächen
überdecken, werden entfernt.

2. Bereich ausschneiden: Bereiche von Flächen, die von der aktiven Fläche
überdeckt werden, werden entfernt.

3. Drehsinnkorrektur: Die Drehsinnkorrektur wird benutzt um die Punkte
einer Fläche im Uhrzeigersinn anzuordnen. Generell sollten Flächen im
Gegenuhrzeigersinn erzeugt werden, dies führt dazu, dass die Punkte im
Uhrzeigersinn numeriert werden. Wenn Punkte im Uhrzeigersinn numeriert
sind, kann eine Fläche auf viele Arten aufgespaltet oder manipuliert werden.
Wenn jedoch die Numerierung linksläufig ist, braucht es die
Drehsinnkorrektur um die Numerierung umzukehren.

4. Bereich löschen: Entfernt die ausgewählte Fläche.

5. Bereich hinzufügen: Bereich hinzufügen (oder Öffnung bilden) wird
verwendet um Inseln, Seen und andere Öffnungen innerhalb von Flächen zu
bilden. Um eine Öffnung zu bilden, erzeugen Sie zuerst ein neues Objekt,
dann Flächenfunktionen>Bereich hinzufügen. Sie sehen sofort die
Öffnung in der darunterliegenden Fläche, wenn Sie rechtsherum digitalisieren
(gegenüber dem normalen Verfahren, die Punkte linksherum zu numerieren).
Um die Öffnung mit einem See zu füllen, sollte der See in einem
unterschiedlichen Layer erzeugt werden, indem man die Ränder der Öffnung
einfängt.

Anmerkung: Subtrahieren und Ausschneiden geht nur mit Objekten, die mit dem
Auswahlwerkzeug ausgewählt wurden.

• Objekte zusammenfügen: Verbinden Sie mehrere Objekte im aktiven Layer zu

einem Objekt. Verwenden Sie das Auswahlwerkzeug und die Strg- (Ctrl-)Taste,
um mehrere Objekte auszuwählen. Dieser Befehl arbeitet mit Linien und Flächen.

• Letztes Objekt auswählen: Nützlich für das Auswählen von gerade erzeugten
Objekten, um sie zu verschneiden oder wieder zu löschen.

• Ausgewähltes Objekt kopieren: Objekte können von anderen Layern zum Layer
kopiert werden, der gerade bearbeitet wird. Linien können nur zu Linien, Flächen nur
zu Flächen und Punkte nur zu Punkten kopiert werden. Das Objekt wird im WKT-
Format (Well-Known Text) in der Zwischenablage gespeichert. Mit Objekt einfügen
wird es im neuen Layer eingefügt. Um das Format anzusehen, kopieren Sie die den
Inhalt der Zwischenablage in eine Textdatei.

• Fangtoleranz einstellen: Der Standardwert ist 15 Pixel. Werte grösser als 35
werden nicht empfohlen.

• UTM zu geographischen Koordinaten: Kopiert die geographischen Koordinaten in
die Zwischenablage. (Dieses Werkzeug arbeitet nur mit Wisconsin
Transversalmerkator WTM)



Werkzeug-Menü:

• Layerbibliothek laden: Diese Funktion vereinfacht das Auswählen von GIS-Layern.
Wenn Sie eine grosse Ansammlung von GIS-Daten in Ihrem Unternehmen haben,
ergeben sich Probleme mit der Namensgebung der verschiedenen Layer. Hinzu
kommt, dass die Daten an verschiedenen Orten gespeichert sind. Sie gewinnen eine
Übersicht wenn Sie alle Daten in einer Datenbankdatei (DBF) ablegen, wo jeder
Layer mit einer allgemeinen Namensabkürzung und dem absoluten Pfad abgelegt ist.
Sobald Sie solch eine Tabelle erzeugt haben, laden Sie diese und klicken Sie auf die
Shape-Dateien, die Sie dem Projekt hinzufügen wollen. fGIS fügt diese als neue
Layer in das Inhaltsverzeichnis Ihres Projektes ein.

Hier ist ein Beispiel einer DBF-Datei, die die Quellen, Bezeichnungen und INI-Dateien
enthält:



Sie können den Befehl Umgebungsvariable>Umgebungsvariable hinzufügen
verwenden, um einer Variablen den absoluten Pfad zu einem Verzeichnis zuzuweisen.
Dieser Pfad wird beim Beenden in der Datei "env.txt" im Programmverzeichnis
gespeichert. Diese Datei wird immer eingelesen, wenn die Umgebungsvariablen
gebraucht werden. Unten ist eine Beispieldatei mit den Variablen, wie sie oben
benutzt werden:

In diesem Beispiel sind die Shape-Dateien im Programmverzeichnis des Benutzers
abgelegt. Klicken Sie in der Layerbibliothek auf den Layer, den Sie laden möchten.

Benutzer können auch eine andere Datei als "env.txt" mit Umgebungsvariablen
laden. Mit dem Befehl Umgebungsvariablen>Umgebungsvariablen laden wird
eine neue Textdatei mit Umgebungsvariablen eingelesen. Der Name und Speicherort
dieser neuen Datei wird in der Datei fGIS.ini im Programmverzeichnis festgehalten
und ist von nun an die Standarddatei mit den Umgebungsvariablen.

Die Layerbibliothek muss zwingend eine Spalte mit dem Namen SOURCE haben.
Weitere Spalten sind optional. Wenn eine Spalte mit dem Namen INI_FILE
angegeben wird, so werden von den dort angegebenen Dateien die
Layereigenschaften übernommen. Eine Spalte die mit ALIAS bezeichnet ist, wird als
Namen des Layers in der Legende verwendet. Vorrang hat aber der Namen, der in
der INI-Datei festgelegt ist.

Stimmt der Pfadname nicht, so kommt es zu folgender Fehlermeldung:



 

• Shape-Datei umprojizieren: Diese Funktion transformiert ganze Shape-Dateien
von geographischen Koordinaten zu UTM-Koordinaten und umgekehrt.

Wisconsins UTM-Zonen finden Sie hier. Weltweite UTM Zonen werden von fGIS
unterstützt.

• Einheitenumrechner: Dieses Hilfsprogramm wandelt Masseinheiten um. Beenden
Sie den Editiermodus, bevor Sie den Einheitenumrechner verwenden.

Gewöhnlich verwenden Sie den Einheitenumrechner, indem Sie einen Wert aus einer
Attributtabelle kopieren (klicken Sie eine Zelle an, um sie dann mit einem Rechtsklick
der Maustaste zu kopieren). Im Einheitenumrechner fügen Sie diesen Wert in das
Eingangstextfeld (Input) ein. Im unteren Beispiel werden Quadratmeter in Morgen
umgerechnet.



• dBase-Tabelle mit Shape-Datei verknüpfen: Diese Funktion verknüpft eine
dBase-Datenbank mit der Attributtabelle einer Shape-Datei über ein Feld mit
gemeinsamen Daten. Dieses gemeinsame Feld braucht nicht den gleichen Namen zu
haben, sollte jedoch die gleiche Art von Daten enthalten.
Die Verbindung wird nur in einem Eins-zu-Eins-Verhältnis durchgeführt. Nur der
erste Datensatz in der dBase-Tabelle ist in eiem Eins-zu-Vielen-Verhältnis mit der
Shape-Datei verbunden.
Das Verbinden kann einige Minuten dauern, je noch Grösse der Shape-Dateien und
dBase-Datenbank.
Anmerkung: Microsoft Excel®-Tabellen können als dBase-Dateien für den Gebrauch
in fGIS exportiert werden.

• Access-Daten mit Shape-Datei verknüpfen: Verknüpfte Felder der Datenbank
sind sofort als Layerattribute verwendbar. Nur Felder vom Typ Integer können
verknüpft werden. In einem Kartenprojekt kann jeweils nur eine Verknüpfung
verwendet werden. Verknüpfungen können in einer Datei (.join) gesichert und bei
Bedarf erneut geladen werden.



Die Sortierung der Shape-Datei kann die Qualität einer Verbindung zur Access-
Tabelle verbessern:

a. Diese Funktion sortiert die ausgewählte Shape-Datei anhand des
ausgewählten Attributs und speichert sie als neue Shape-Datei. Die neue,
sortierte Shape-Datei sollte der Legende hinzugefügt werden, um sie bei der
Verknüpfung in (b) zu verwenden.

b. Die Access-Tabellendaten sind nun vor der Verknüpfung sortiert. Die
Verknüpfung funktioniert gut, wenn ein Eins-zu-Eins-Verhältnis zwischen den
Werten der Shape-Datei und der Access-Tabelle besteht und wenn die Werte
in beiden Datensätzen sortiert wurden.

Eine Access-Tabellenverknüpfung kann gespeichert werden und wieder zum Projekt
geladen werden.

• Diagram Designer: Einfaches Programm zum Erstellen von Flussdiagrammen,
Ablaufplänen etc. Mit Diagram Designer können einfach Diagramme aller Art erstellt
werden. Es werden nur einige Shapes mitgeliefert, die für einfache Aufgaben aber
ausreichen. Fertige Grafiken lassen sich als WMF, EMF, BMP, JPEG, PNG, MNG, GIF
und PCX exportieren. Ausführliche Anweisungen über das Verwenden des Diagram
Designers finden sind hier.

• Geographische Koordinaten zu WTM: Dieser Dialog berechnet die DTRS-Nummer
in der angezeigten Flächen-Shape-Datei und kopiert sie in die Zwischenablage. DTRS
steht für Direction (Richtung), Township (Ort), Range (Bereich), Section (Abschnitt).
Layer mit dieser Struktur werden im Westen der USA durch die dortigen
Vermessungsstellen zur Verfügung gestellt. Diese Layer findet man typischerweise
unter der Bezeichnung PLSS. (In der State_Park-Beispieldatei unter dem Namen
"Section_lines".)

 
• Textdatei importieren: Die zu importierende Textdatei (CSV) muss vier Felder in

folgender Reihenfolge enthalten: ID, Rechtswert (Länge), Hochwert (Breite), Text.
Die Feldnamen (Header bzw. Kopfzeile) können benutzerdefiniert sein, wobei nur die
ID- und Text-Felder als Attribute übernommen werden. Durch Komma oder
Tabulator getrennte Einträge können verwendet werden. Texteinträge sind zwischen
Anführungszeichen zu setzen. Achtung! Die Ländereinstellungen in der
Systemsteuerung von Windows wirken sich aus!!! Sehen Sie eine Beispieltextdatei
hier.



Klicken Sie auf Import um zu beginnen. Die Texttabelle wird als neue Shape-Datei
dem Projekt hinzugefügt.
Zusätzliche Datenwerte können den neuen Attributen der Shape-Dateien über eine
Verbindung mit einer Datenbank hinzugefügt werden (siehe oben).

• Bildkatalog: Bildkataloge sind dBase-Tabellen mit einer Liste von Bildern, die alle
gemeinsam in die Ansicht geladen werden. Die Bilder sind typischerweise unter dem
Feldnamen "Image" gespeichert. Der volle Pfad und der Dateiname müssen
enthalten sein. Optional können alle zu ladenden Bilder in der Legende ausgeblendet
werden. Die Ansicht ein-, Ansicht aus-, Legende ein- und Legende aus-
Schaltflächen wirken auf die im Kartenprojekt als Layer geladenen Bilder mit der im
Listenfeld markierten Dateierweiterung.

• Sehen Sie Anweisungen für die 3D-Ansicht hier.
• Hyperlink-Verknüpfung: Das Hyperlink-Verknüpfungswerkzeug ändert die

Funktion des Objekte auswählen-Knopfes. Wenn eine Shape-Datei ausgewählt ist,
wird die im Hyperlinkfeld dieser Shape-Datei angegebene Datei, im jeweilig
verknüpften Programm geöffnet (entsprechend der in Windows voreingestellten
Verknüpfung mit der Dateiendung). Bilder, Dokumente, Webseiten, etc. können
verwendet werden.

• Suche nach Gemeinde: Dieses Werkzeug erfordert, dass ein passender PLSS-Layer
mit einem DTRS Attribut geladen ist.

• Routenführung: Mit Routenführung werden Adressen lokalisiert (mittels Eintrag in
der von Feld- und Adresse finden-Schaltfläche) und die beste Route zwischen zwei
Adressen (Route finden-Schaltfläche) auf dem Routen-Layer berechnet. Der
Routen-Layer ist meist eine Strassen-Shape-Datei, welche auf den US TIGER
Strassendaten basiert. Solch ein Layer ist in den State_Park.zip fGIS-Beispieldaten
enthalten und für Wisconsin von der Abteilung für Natürliche Ressourcen (DNR) zur
Verfügung gestellt. Eingabeadressen müssen in der Form
Strassennamen/Hausnummer vorliegen. Ist nur der Strassenname eingegeben,
wird die Strasse markiert. Hausnummer-Felder müssen numerisch sein (z.B.
E14450 funktioniert nicht). Die Schieberegler Strassen bevorzugen und
Autobahnen bevorzugen regeln auf welchem Strassentyp die Route basiert. Für
WDNR Benutzer, gilt folgendes Kriterium als Strasse: CFCC >= 'A4'. (Die Feldnamen
und Einträge müssen gegebenenfalls angepasst werden.) Die Routenfunktion fügt
dem Kartenprojekt einen versteckten Layer namens "RouteDisplay" zu, um die
Resultate der Route zu speichern. Dieser Layer wird entfernt, wenn der Dialog
geschlossen wird. Das Speichern unter-Kommando schliesst den Routendialog.

• Live GPS-Position: Live GPS-Position verwendet die aktuelle Position eines an der
seriellen Schnittstelle (COM Port) angeschlossenen GPS-Empfängers für die Anzeige
und Positionierung. Als Ausgabedatenformat muss im GPS-Empfänger NMEA
eingestellt sein! Die angezeigte GPS-Position kann auf einem Linien-Layer einrasten,
um z.B. Bewegungen entlang einer Strasse, etc. zu korrigieren. Jedesmal wenn der
GPS-Empfänger eine neue Position ausgibt, kann ein Klick mit der linken Maustaste
auf diese Position in der Ansicht simuliert werden. Diese Funktion ist z.B. nützlich,
um neue Objekte (Linien, Punkte) in einer Shape-Datei zu erzeugen oder Attribute
anzuzeigen. Der aktuelle Mauszeiger wird an die neue Position bewegt, daher sollte
man sicherstellen, dass offene Dialogfenster nicht im Weg sind! Das Live GPS
Werkzeug fügt den versteckten Layer "GPSdisplay" zur Ansicht hinzu. Dieser Layer
wird entfernt wenn der GPS-Dialog geschlossen wird. Der Befehl Kartenprojekt
Speichern unter schliesst ebenfalls den GPS-Dialog.

• Shape-Dateien zuschneiden: Diese Funktion dient dazu einen Linien- oder
Flächen-"Eingabelayer" mittels eines Flächenlayers als Abschneideumrandung
zuzuschneiden. Punktlayer können NICHT mit diesem Dialog zugeschnitten werden.
Punkte sind entsprechend über den Lagebezogene Auswahl-Dialog auszuwählen
und mittels Layerexport in Shape-Datei in eine neue Shape-Datei zu exportieren.

• Shape-Dateien zusammenfügen: Dieser Dialog kann verwendet werden, um
mehrere Shape-Dateien zu einer neuen Shape-Datei zu verbinden. Alle Felder von
allen Layern werden in die neue Datei übernommen.

• Feld-Manager für neue Shape-Dateien: Der Feld-Manager für neue Shape-
Dateien dient dazu Felder zu definieren, die bei einer neu erzeugten Shape-Datei



hinzugefügt werden. Die Feldbeschreibungen werden den Feldvorgaben über den
Feld hinzu-Knopf angefügt. Ist die Feldvorgabe fertig, wird sie mittels des Zur
Liste-Knopfes zur Auswahlliste hinzugefügt. Der Liste speichern-Knopf speichert
die angezeigte Feldvorgabenliste in der Datei "fgis.ini". Um die Feldvorgaben für
eine neue Shape-Datei zu verwenden, ist ein Eintrag aus der Liste auszuwählen und
mit dem Vorgabe nutzen-Knopf anzuwenden. Das Feldvorgabeformat ist wie folgt:
FeldName1:FeldTyp1:FeldLänge1|FeldName2:FeldTyp2:FeldLänge2

• Pfade im Projekt neu zuweisen: Diese Funktion dient dazu individuelle
Pfadangaben im einer Kartenprojektdatei (.ttkgp) zu ändern bzw. anzupassen. Das
kann nützlich sein, wenn Layerdaten, Projektdateien oder Ordner verschoben
wurden. Die Pfade werden sofort geändert und in die Projektdatei übernommen,
wenn über den Neuer Pfad-Knopf ein neuer Pfad gesetzt wird. Um die Änderungen
zu sehen, ist die Projektdatei neu zu laden (Datei>Öffnen...). 

Hilfe-Menü:

• fGIS Hilfe F1 zeigt diese Hilfe an.
• Über fGIS zeigt die Copyright-Informationen an. Die Datei "license.txt" im fGIS-

Programmverzeichnis liefert zusätzliche Details. 



  

Werkzeugleiste

• Speichern 
Speichert das Projekt und die aktuelle Ansicht. Um das Projekt mit einem anderen
Namen zu speichern (das Ursprüngliche unverändert lassend), verwenden Sie
Speichern unter... aus dem Datei-Menü.

• Drucken einer einfachen Karte 
Nachdem Sie Karte drucken angeklickt haben, fordert fGIS Sie auf einen
Kartentitel, Kopfzeile und Fusszeile einzugeben. Sie können den Massstab auch
angeben und die Schriftart mit der Kartentitel, Kopfzeile und Fusszeile gedruckt
werden. Eine Druckvorschau wird ebenfalls zur Verfügung gestellt.
Tip: Vor dem Verwenden des "Druckens einer einfachen Karte", benutzen Sie das
Zentrierwerkzeug, um einen spezifischen Punkt für die Kartenmitte zu wählen. So
können Sie den Druckauftrag mit ähnlichen Grenzen wiederholen, wenn Sie weitere
Karten drucken.
Anmerkung: Einige Druckertreiber richten Bild- und Vektorlayer falsch aus, wenn
Kartentitel, Kopfzeile und Fusszeile in einem einfachen Druckauftrag eingeschlossen
sind. Wenn das geschieht, lassen Sie die Textfelder für Kartentitel, Kopfzeile und
Fusszeile leer.

fGIS bietet drei zusätzliche Druckoptionen an:
• Der Befehl Karte senden an Word (Datei>Karte senden an>Microsoft Word)

sendet das Bild der aktuellen Ansicht mit einer vom Benutzer spezifizierten
Auflösung und Massstab an Microsoft Word®.Der Benutzer hat die Wahl das
Bild einem vorhandenen Dokument hinzuzufügen (laden Sie das Dokument)
oder ein neues Dokument zu erstellen. Ein Wisconsin DNR MFL-
Kartenüberschriftsformular ist im fGIS Verzeichnis vorhanden, falls es
benötigt wird. Das "Verschieben" Bildwerkzeug in Word verschiebt das Bild,
ohne den Massstab zu ändern oder das Bild zu verzerren. Sie können das Bild



hin und her verschieben, um es optimal zu platzieren. Ausserdem fügt fGIS
den Massstab (z.B. 1:7920) als Text in Word hinzu. Der Befehl Karte senden
an Word ist mit Word 97, 2002 und 2003 mit zufriedenstellenden Resultaten
geprüft worden.

• Benutzen einer Druckvorlage. Der rechte Teil des Druckdialogs erlaubt das
Drucken anhand einer Druckvorlage. Die Druckvorlagen ermöglichen das
Platzieren von weiteren Texten an frei definierbaren Stellen auf dem
Kartenblatt. Ein Druckvorlagenbeispiel (print.tpl) ist für Benutzer mit
Vorkenntnissen, die ihre Kartenlayouts selbst entwerfen möchten, im
Programmverzeichnis vorhanden. Die Druckvorlagendateien können mit
einem Texteditor verändert werden.

• Eine vierte Möglichkeit ist der Befehl Kartenansicht exportieren. Das Bild
wird anschliessend mit dem Diagram Designer überarbeitet. Sie können
Überschriften, Legenden, Anmerkungen und Symbole im Diagram Designer
hinzufügen.

• Layer hinzufügen/löschen 

Fügen Sie Layer hinzu oder löschen Sie Layer mit diesen Tasten. Wenn Sie die
Hinzufügentaste (+) anklicken, öffnet sich ein Dialog zum Suchen eines Layers.
Gehen Sie zum Verzeichnis, in dem sich die Dateien, die Sie fGIS hinzufügen
möchten, befinden. Sie können mehr als eine Datei auswählen, indem Sie die Shift-
oder Strg-(Ctrl-)Taste gedrückt halten, wenn Sie auf den Namen der Datei klicken.
Die Löschentaste (-) entfernt den Layer aus dem Inhaltsverzeichnis (aber nicht die
Datei, die sich auf Ihrer Festplatte befindet).

Das Hinzufügen und Löschen geht nicht, wenn Sie sich im Editiermodus befinden.
(Beenden Sie den Editiermodus zuerst.)

• Zoom und Position 
fGIS liefert eine Anzahl von Werkzeugen, um die Kartenansicht zu ändern.

• Das Erste, mit einer Weltkugel symbolisiert, zeigt den vollen Umfang aller
geladenen Layer. (wenn Sie den Umfang eines bestimmten Layers sehen
möchten, verwenden Sie Auf aktiven Layer zoomen im Layermenü)

• Die folgenden, Zoom kleiner oder grösser (- und +), verändern die Grösse in
ganzen Schritten.

• Das vorherige Ansicht-Werkzeug geht zurück zur vorhergehenden Ansicht.
Nur die 10 letzten Ansichten werden gespeichert.



• Das Vergrösserungsglas ist ein freies Zoomen. Ziehen Sie mit gedrückter
linker Maustaste von links oben nach rechts unten, der umfasste Bereich wird
nun vergrössert dargestellt. Ziehen Sie mit gedrückter linker Maustaste von
rechts unten nach links oben, der umfasste Bereich wird nun verkleinert
dargestellt.

• Das dynamische Zoomen vergrössert das Bild, wenn mit gedrückter linker
Maustaste der Cursor nach oben geschoben wird. Nach unten schieben
verkleinert das Bild.

• Das Verschiebewerkzeug (Hand) wird benutzt, um die Ansicht mit der Maus
zu verschieben. Halten Sie die linke Maustaste gedrückt und verschieben Sie
das Bild.

• Das Zentrierwerkzeug zentriert die Ansicht auf den Punkt, den Sie mit der
linken Maustaste bestimmen.

• Information 
Das Informations-Werkzeug zeigt die Attribute jedes möglichen Objekts im aktiven
Layer an. Klicken Sie das Objekt an. Es blinkt zuerst rot und dann gelb, dann öffnet
sich die Attributtabelle. Wenn der Editiermodus eingeschaltet ist, können die
Attribute für das Objekt geändert werden.

Anmerkung: Wenn Sie das Informations-Werkzeug benutzen, aber nicht imstande sind,
das Objekt anzuklicken, verschieben Sie den Layer, die dem sich das Objekt befindet, auf
eine höhere Position im Inhaltsverzeichnis. Jeder Layer verhält sich wie eine Glasscheibe.
Sie können nicht ein Objekt in einem unteren Layer anklicken, wenn ein Objekt aus einem
höheren Layer dieses überdeckt.

Wenn Sie im Editiermodus (Rechtsklicken in der Kartenansicht und Bearbeitung
starten wählen) sind, können Sie das Informations-Werkzeug benutzen, um die
Datenwerte zu ändern, die mit einem Objekt verbunden sind. Nachdem Sie auf ein
Objekt geklickt hat, öffnet sich eine Tabelle, die der folgenden ähnlich ist, mit allen
Eigenschaften des Objekts:

Rechtsklicken mit der Maustaste in der linken Spalte (UID) ermöglicht das
Hinzufügen, Ändern und Löschen eines Feldes. Neue Felder werden an Ende der Liste
angefügt. Zweimal klicken mit der linken Maustaste in der rechten Spalte ermöglicht
das Ändern der Attributwerte. Klicken Sie auf OK, wenn Sie fertig sind, um Ihre
Änderungen zu speichern.

• Auswahl 

Das Auswahl-Werkzeug erlaubt Benutzern, Objekte aus dem aktiven Layer
auszuwählen. Ausgewählte Objekte werden in Rot hervorgehoben. Mehrere Objekte
können ausgewählt werden, indem man die Strg- (Ctrl-)Taste gedrückt hält.
Ausgewählte Objekte werden im Editiermodus mit dem Befehl Objekte vereinigen
zu einem Objekt.



• Messen 
Klicken Sie Punkte an und folgen Sie einer Linie oder Fläche. Klicken Sie doppelt
beim letzten Punkt und die Länge und der Flächeninhalt werden angezeigt. Masse
werden in Morgen, Fuss, Ketten (1 Kette = 66 Fuss) und in den Meilen angezeigt,
ausserdem in metrischen Massen.

Anmerkung: fGIS produziert nur Masse für Projekte, die auf metrischen oder auf Fuss
bezogenen Koordinatensystemen beruhen. Wenn Sie Daten mit geographischen Koordinaten
(Länge und Breite) verwenden, funktioniert die Messfunktion in fGIS nicht.

• Rasterbild-Export 
Markieren Sie, mit gedrückter linker Maustaste, einen Bereich in der Kartenansicht,
um diesen als georeferenziertes Bild zu exportieren. Das Rasterbild-Export-Werkzeug
kann benutzt werden, z.B. um aus einem Bild eine Teilansicht zu erzeugen.
Nachdem Sie die linke Maustaste loslassen, öffnet sich der folgende Dialog.

Der Vergrösserungsfaktor von 1 speichert das Bild in der Bildschirmauflösung (dies
kann beim Drucken zu einer groben Abbildung führen). Die Erhöhung der Auflösung
ergibt eine grössere Datei, die besser zum Drucken ist, abhängig von der Qualität,
die Sie haben möchten. (Eine Auflösung von 2 ist normalerweise für fGIS-Karten
optimal.)
Bilder können im TIF-, PNG-, BMP- und JPG-Format gespeichert werden (zusammen
mit Georeferenzdateien). Das PNG-Format ist für Karten besonders nützlich, die nur
aus Vektorbildern bestehen, es hält die Dateigrösse verhältnismässig klein.

Wenn Sie das Rasterbild-Werkzeug benutzen, erscheint die Option das Bild im
Diagram Designer, einen Layoutprogramm, zu öffnen. Sie können mehr über den
Diagram Desinger hier erlernen. [Anmerkung: Exportierte Bilder müssen in
einem PNG-, BMP- oder JPG-Format gespeichert werden, wenn sie im Diagram
Desinger verwendet werden sollen.]



• Objekte zerteilen 
Das Zerteilen-Werkzeug (ein Axt-Symbol) teilt eine Fläche oder eine Linie in
kleinere Einheiten. Das Zerteilen-Werkzeug berechnet Fläche und Umfang jeder
Untereinheit neu, wenn eine Fläche oder eine Linie geteilt wird.

Aufspalten einer Fläche entlang einer Linie
(Doppelklicken, um das Verfahren zu beenden)

Eine der einfachsten Methoden, um die Waldbedeckung (oder irgendwelche andere
Arten der Landbedeckung) zu digitalisieren, ist sie zuerst zu umreissen und dann das
Zerteilen-Werkzeug zu benutzen, um das Ganze in seine Teile zu zerlegen.
Gelegentlich können Sie eine Fläche antreffen, die eine Warnung anzeigt, dass sie
nicht aufgespaltet werden kann, wenn Sie versuchen, sie zu unterteilen. Das wird
durch irgendeine Unregelmässigkeit in der Struktur der Daten der Fläche verursacht.
Wenn dies geschieht, benutzen Sie das Editier-Werkzeug, um das Objekt etwas zu
korrigieren und versuchen Sie dann das Zerteilen-Werkzeug noch einmal.

Warnung! Versuchen Sie nicht, der Grenze eines Objektes zu folgen. Da das Zerteilung-
Werkzeug keine anderen Objekte einfängt, ergibt der Versuch einer anderer Grenze zu
folgen "Waisen" (Flächensplitter, die Sie löschen und säubern müssen). Planen Sie Ihre
Technik, um Flächen zu teilen.

Tip: Das Zerteilen-Werkzeug ist für das Säubern von die GPS-Messungen nützlich,
die importiert werden. Es kann verwendet werden, um aus GPS-Messungen
Segmenten zu schneiden.

• Editier-Werkzeug/Auswahl-Werkzeug 
Wählen Sie den Layer, der die Objekte enthält, die Sie ändern möchten, dann klicken
Sie mit der rechten Maustaste in die Kartenansicht und wählen Bearbeitung
starten. Aktivieren Sie das Editier-Werkzeug und dann das Objekt, das Sie ändern
möchten. Klicken Sie nahe des Objektes, um zu vermeiden beim ersten Klicken einen
Punkt zu verändern. Verschieben Sie Punkte oder setzen Sie neue Punkte mit dem
Editier-Werkzeug.
Sie können das Editier-Werkzeug auch benutzen, um ein Objekt zu löschen, indem
Sie es zuerst auswählen und dann die Löschtaste auf Ihrer Tastatur benutzen.
Zusätzliche Flächen-Funktionen, die mit dem Editier-Werkzeug verwendet werden
können, werden unten aufgeführt.

Anmerkung: Es ist häufig am Einfachsten, eine komplizierte Form zu digitalisieren, indem
man sie zuerst mit einer einfachen Fläche umgibt. Dann benutzen Sie das Editier-
Werkzeug, um die Form zu an den Gegenstand anzupassen, der digitalisiert wird.

• Neues Objekt 
Wenn Sie im Editiermodus sind, klicken Sie Neues Objekt erstellen an, um ein
neues Objekt im aktiven Layer einzusetzen. Um einen neuen Layer hinzuzufügen,
klicken Sie mit der rechten Maustaste in die Kartenansicht und wählen Neuer Layer.



Ein Untermenü erlaubt die Wahl der passenden Layerart:

Ihnen wird die Wahl gegeben, zur Attributtabelle Fuss, Morgen, Meter oder Hektar
hinzuzufügen.

Beachten Sie, dass das Editiermenü einige Flächen-Funktionen miteinschliesst:

Diese Werkzeuge machen es möglich, komplizierte Objekte in fGIS zu digitalisieren,
ohne "Waisen" oder Lücken zwischen Objekte zu produzieren. Sehen Sie die
folgenden Beispiele (Ansichtreihenfolge von links nach rechts):



Die Drehsinnkorrektur wird benutzt um die Punkte einer Fläche im Uhrzeigersinn
anzuordnen. Generell sollten Flächen im Gegenuhrzeigersinn erzeugt werden, dies
führt dazu, dass die Punkte im Uhrzeigersinn numeriert werden. Wenn Punkte im
Uhrzeigersinn numeriert sind, kann eine Fläche auf viele Arten aufgespaltet oder
manipuliert werden. Wenn jedoch die Numerierung linksläufig ist, braucht es die
Drehsinnkorrektur um die Numerierung umzukehren.

Bereich löschen entfernt die ausgewählte Fläche.

Bereich hinzufügen (oder Öffnung bilden) wird verwendet um Inseln, Seen und
andere Öffnungen innerhalb von Flächen zu bilden. Um eine Öffnung zu bilden,
erzeugen Sie zuerst ein neues Objekt, dann "Flächenfunktionen>Bereich
hinzufügen". Sie sehen sofort die Öffnung in der darunterliegenden Fläche,
wenn Sie rechtsherum digitalisieren (gegenüber dem normalen Verfahren, die
Punkte linksherum zu numerieren). Um die Öffnung mit einem See zu füllen, sollte
der See in einem unterschiedlichen Layer erzeugt werden, indem man die Ränder der
Öffnung einfängt.

Beachten Sie den bedeutenden Unterschied zwischen dem Verwenden von "Bereich
hinzufügen" und dem Subtrahieren. Mit "Bereich hinzufügen" muss der Benutzer zuerst
den Befehl wählen und dann die Öffnung digitalisieren.

Mit den anderen Flächenfunktionen digitalisiert der Benutzer zuerst die neuen
überlappenden Flächen, dann wählt er den Befehl zum Subtrahieren oder Ausschneiden.

• Polares Anhängen 
Benutzen Sie diese Werkzeug um mit Azimut und Abstand den folgenden Punkt auf
einer Linie oder in einer Fläche festzulegen. Geben Sie das Azimut (Richtung bezogen
auf Nord) in Grad oder Grad-Minute-Sekunden ein, dann geben Sie den Abstand zum
nächsten Punkt ein. Dieses Werkzeug in fGIS kann auf einfache Art Wegpunkte oder
Kurse, welche mit GPS aufgenommen wurden, in fGIS darstellen.



Anmerkung: Flächen werden in fGIS mit mathematischen Funktionen errechnet, aber
Bildschirmauflösung und der Zoommassstab haben einen Effekt auf der Präzision der
Punktkoordinaten. Je höher die Bildschirmauflösung (1024x768 ist besser als 800x600) und
je grösser der Massstab, umso exakter die Koordinaten der Punkte, die der Benutzer
erzeugt (und so auch der Flächen).

• Rückgängig/Wiederherstellen 
Benutzen Sie Rückgängig oder Wiederherstellen um einen falschen Punkt zu
entfernen oder einen gelöschten Punkt wieder herzustellen, wenn Sie am Editieren
sind. Diese Werkzeuge arbeiten nicht mit anderen Funktionen zusammen.

• Fangen
Wenn Sie digitalisieren, können Sie das Fangen von Punkten aus irgendeinem Layer
ermöglichen, indem Sie den passenden Layer aus der Drop-Down-Liste wählen. Die
Layernamen, die in der Kartenlegende verwendet werden, werden wie in diesem
Beispiel angezeigt:

Der Layer kann jederzeit geändert werden, z.B. können Sie mit Strasse beginnen
und dann zu einem Strom wechseln, wenn Sie Gegenstände im Hydrolayer
digitalisieren. Anmerkung: Die Funktion Fangen in fGIS geht nur auf Punkte von
Linien oder Flächen, nicht auf Linien selbst.



  

Layereigenschaften

Die Layereigenschaften erreicht man in fGIS, indem man doppelt auf einen Layernamen in
der Legende klickt. (Anmerkung: Sie müssen den Editiermodus beenden, bevor Sie die
Layereigenschaften für einen Layer zugänglich machen können.)
fGIS und der Freeware TatukGIS-Viewer (beide mit dem TatukGIS SDK gemacht) haben
ähnliche Eigenschaften. Es wird empfohlen die TatukGIS Viewer-Hilfe als zusätzliche
Informationsquelle mit Beispielen zu lesen. Sie können fGIS Projektdateien mit dem
TatukGIS Viewer, der einige unterschiedliche Bearbeitungsmöglichkeiten anbietet,
bearbeiten. Sie können ein Testexemplar des Viewers hier herunterladen.

• Die Layereigenschaften bieten umfangreiche Möglichkeiten für die Gestaltung der
Anzeige von Vektordaten an. Sie sind über verschiedene Karteireiter erreichbar. Im
Folgenden sind grundlegenden Eigenschaften erklärt:

Die erste Option, die Sie wahrscheinlich
vom Layerreiter benötigen, ist
Transparenz. Wenn Sie ein
Flächenobjekt bearbeiten, verringern
Sie die Transparenz, um Gegenstände
aus unteren Layern sehen zu können.
Sie können das Flächen-Füllmuster
(siehe unten) auf transparent
einstellen, um nur den Umriss des
Objektes ohne Füllung zu sehen.
Minimum/Maximum Massstab stellt die
Zoomniveaus ein, zwischen denen die
Layer anzeigt werden. Das Kästchen
"Visible" erlaubt es einen Layer nicht
anzuzeigen, ohne ihn aus dem
Inhaltsverzeichnis zu löschen.
In diesem Beispiel werden
Layergegenstände sichtbar, wenn der
Massstab 1:15840 oder grösser ist und
die Fläche des Gegenstandes grösser
als 5 Acres (Morgen) ist.



Der Darstellungsreiter wird für das
Herstellen von thematischen Karten
benutzt (unterschiedliche Farben,
Linienbreiten, Beschriftungen,
Füllbereiche, usw...), welche den
Attributen der Vektorlayer entsprechen.
Lesen Sie die TatukGIS Viewer-Hilfe für
mehr Details.

Der mittlere Reiter wird "Area" für
Flächenobjekte, "Line" für Linienobjekte
oder "Marker" für Punktobjekte
genannt. Die Reiter in der zweiten
Reihe werden benutzt, um die Farbe,
die Linienbreite, das Symbol oder den
Füllbereich eines Vektorobjektes
darzustellen.
Wenn Sie durch ein Objekt sehen
möchten, stellen Sie das Füllmuster
auf transparent ein. Sie können
teilweise Transparenz durch den
Layerreiter einstellen.
Klicken Sie das untere Kästchen an, um
den Layer in der Kartenlegende mit
dem Layernamen darzustellen.
Es gibt verschiedene Art und Weisen
Symbole Ihren Karten hinzuzufügen.

Eine Möglichkeit sind Punkte, die der
Karte hinzugefügt werden. Diesen
Punkten werden dann Symbole oder
Bilder über den fGIS Eigenschaften-
Dialog zugeordnet (siehe links).
Die andere Möglichkeit ist ein Bild Ihrer
fGIS Karte zu exportieren und in einem
Zeichenprogramm weiter zu
bearbeiten. Hier können Sie Legenden
und Anmerkungen hinzufügen. (Die
Zeichenfunktion in Microsoft Word® ist
für das Kommentieren der Karten
nützlich. Zoner Draw 3 und AutoRealm
sind weitere frei erhältliche
Zeichenprogramme, die in Betracht
gezogen werden können.)



Der Beschriftungsreiter bietet viele
Möglichkeiten für das Aussehen und die
Positionierung der Texte an. Wählen
Sie ein Feld (aus dem Attribut des
Objekts), um es für die Beschriftung zu
verwenden.
Beschriftungen können mehr als ein
Attribut umfassen und aus mehr als
einer Textzeile bestehen. Die Textfolge
in "Field" bezeichnet die Standplatz-
Zahl, die Primärbauholzart und (auf
Zeile 2) die Sekundärbauholzart:

:#<:STAND >,
<:PRIM_TYPE>\n<:SEC_TYPE >

Die Texte innerhalb der Klammern (z.B.
<:STAND >) sind Attributnamen des
Objektes.
Lesen Sie die TatukGIS Viewer-Hilfe für
mehr Details.
Der Diagrammreiter kann benutzt
werden, um ein Torten- oder
Balkendiagramm zu erzeugen, die auf
den Attributwerten eines Objektes
basieren.
Lesen Sie die TatukGIS Viewer-Hilfe für
mehr Details. (ungefähr 1.4 MB,
erfordert einen Internet-Anschluss).



• Die Layereigenschaften für Rasterlayer bestehen aus zwei Reitern: .

Wenn Sie zwei Rasterbilder haben, die Sie überblenden möchten, z.B. um sie beide als
Layer in fGIS zu laden und dem oberen Bild Transparenz geben möchten, damit das
untere Bild durchscheint, benutzen Sie diesen Eigenschaften-Dialog. Hier ist ein
Beispiel eines Schwarzweissluftbildes (links) gemischt mit einer farbigen
Höhendarstellung (aus 3DEM, wobei rot/orange die höchsten Erhebungen darstellen).
Diese Kombination wurde mit den Einstellungen des Rasterlayers erzielt, wie sie unten
gezeigt wird.

Wie mit dem Layerreiter für
Vektordaten, können Sie den Minimal-
und Maximalmassstab einstellen,
zwischen denen das Objekt angezeigt
wird. Sie müssen mit den Transparent-
und Additionswerten experimentieren,
um das beste Aussehen zu erhalten.

Der Pixelreiter stellt weitere
Einstellmöglichkeiten zur Verfügung.
Dies erlaubt die Feineinstellung der
Rasterbilder.

• Anmerkungen können den Layereigenschaften hinzugefügt werden und zusammen mit
dem Projekt gespeichert oder der Layer.ini Datei hinzugefügt werden.
(Layereigenschaften>Layerreiter>Inforeiter).



  

3D-Ansicht 

Die 3D-Ansicht wird über das Werkzeugmenü erreicht.
Das Betrachten einer Landschaft in 3D erfordert zwei Dateien: ein digitales Geländemodell,
mit Höheninformationen und ein Bild der Landschaft. Das DGM alleine kann auch als
Grauwertbild mit Schattierungen betrachtet werden.
Wichtig für die korrekte Anzeige dieses Programmes ist, dass DGM und Landschaftsbild in
den gleichen Grenzen liegen. Es ist nicht nötig, dass die beiden Dateien die gleiche
Projektion haben, da der 3D-Viewer keine räumlichen Koordinaten verwendet.
Es gibt zwei Methoden die benötigten Dateien herzustellen.

• Methode A - Basierend auf einem Landschaftsbild aus fGIS und einem importierten
digitalen Geländemodells (DGM) in den folgenden Formaten:

• Methode B - Basierend auf einem TIF-DGM und einem Rasterbild, welche mit der
fGIS-Funktion "Ansicht nach 3D exportieren" hergestellt wurden.

 
Methode A: USGS DGM und fGIS Landschaftsbild

1. Diese 3D-Ansicht wurde gebildet aus einem USGS 30-Meter digitalen Geländemodell
(DGM) und einem Landschaftsbild, das aus fGIS exportiert wurde. Obwohl das USGS DGM
ein UTM/NAD 27 System benutzt und das fGIS Landschaftsbild WTM/NAD 83 Koordinaten
hat, passen beide gut zusammen, da sie in den gleichen Grenzen liegen.



2. Das Bild oben zeigt eine Ansicht in fGIS mit den Daten aus dem dieses Beispiel
hergestellt wurde. Mit dem fGIS Rasterbild-Export wird der selektierte Bereich exportiert
(mit der 2-fachen Auflösung) und als BMP-Datei gespeichert.

3. Starten Sie nun das Dienstprogramm 3D-Ansicht (Werkzeuge>3D-Ansicht>3D-
Viewer starten). Laden Sie ein Geländemodell in den 3D-Viewer. Das Geländemodell wird
in Grauschattierungen dargestellt (siehe Ansicht oben).



Benutzen Sie die Maus, um die Ansicht zu bewegen:
Shift + linke Maustaste hebt oder senkt die Landschaft.
Strg (Ctrl) + linke Maustaste dreht die Ansicht um Mittelachse.
Alt + linke Maustaste dreht die Ansicht um die x- oder y-Achse.
Mit gedrückter linker Maustaste wird die Ansicht gezoomt, wenn die Maus nach
oben oder unten bewegt wird.

4. Laden Sie nun das Landschaftsbild (gespeichert im Schritt 2), um eine 3D-Ansicht zu
bilden. Das Orthofoto wurde ausgeblendet, aber die Linien wurden beibehalten.

Die Darstellung der 3D-Ansicht (teilweise oben dargestellt) ermöglicht Anpassungen für
Farbe, Beleuchtung, Bildgrösse, usw. Spielen Sie mit den Steuerungen, um zu sehen was
sie bewirken.
Beachten Sie, dass die Daten, die in diesem Beispiel verwendet werden, im "State_Park.zip"
Beispielprojekt enthalten sind.
 
Anmerkung: Sie können die Daten aus fGIS auch mit 3DEM oder LandSerf verwenden. Das
Verfahren ist in diesen Programmen ein wenig komplizierter, aber sie bieten zusätzliche
Eigenschaften einschliesslich Bildanimation und GPS-Unterstützung an.



Methode B: Ansicht der fGIS-Daten zu 3D exportieren

fGIS enthält ein 3D-Programm, welches ein DGM und ein Landschaftsbild in identischen
Grenzen erzeugt und exportiert. Es erfordert, dass irgendein DGM als Layer in fGIS
enthalten ist.
Der 3D-Export gibt die Daten in vier Standardbildbreiten aus. Das Programm funktioniert
nicht richtig, wenn die DGM-Breite keine gerade Anzahl von Pixeln hat. Auch kann es
blockieren, wenn das Eingabebild zu gross ist. Halten Sie das DGM verhältnismässig klein,
640 oder 800 Pixel sollten nicht überschritten werden. Die Auflösung kann ebenfalls erhöht
werden, aber 2x ist normalerweise genug (Text und Linien werden grösser). Speichern Sie
das DGM als TIF-Datei und das Ausgabebild als BMP-Datei.
Um das TIF-DGM im 3D-Viewer zu laden, wählen Sie als Dateityp "*.tif". Die Qualität des
TIF-DGMs hängt direkt mit der Auflösung zusammen. Niedrige Auflösungen der Bilder
produzieren ein rauhes Geländemodell.



  

Diagram Designer - fGIS Seitenlayoutmodul

Wenn Sie ein Rasterbild exportieren, offeriert fGIS Ihnen die Möglichkeit das Bild im
Diagram Designer zu öffnen.
Der Diagram Designer ist ein einfaches Programm zum Erstellen von Flussdiagrammen,
Ablaufplänen etc. Mit Diagram Designer können einfache Diagramme aller Art erstellt
werden. Es werden nur einige Shapes mitgeliefert, die für einfache Aufgaben aber
ausreichen. Fertige Grafiken lassen sich als WMF, EMF, BMP, JPEG, PNG, MNG, GIF und PCX
exportieren.

• 1. Karten können mit einer Ansammlung von geometrischen Objekten, Texten und
Symbolen kommentiert werden, die in Paletten gespeichert sind. Die aktive Palette
kann durch das Rechtsklicken mit der Maus durch eine andere Palette ersetzt
werden. Vektorobjekte, Bilder und gruppierte Objekte können zu Paletten gemacht
und gespeichert werden. Eine Vielzahl von Symbolpaletten ist in fGIS mit
eingeschlossen.

• 2. Der Seiteninhalt kann auf vier verschiedenen Ebenen verteilt werden, so dass
Eigenschaften einer Ebene geändert werden können, ohne versehentlich andere
Ebenen zu ändern. Eine Kartenüberschrift kann z.B. auf die globale Schablone und
Text oder Symbole auf andere Ebenen gesetzt werden.

• 3. Benutzer können ihre eigenen Paletten mit häufig verwendeten Symbolen oder
Gegenständen selbst herstellen. Ordnen Sie die Symbole einfach auf einer Seite an
und  wandeln Sie dann den Entwurf in eine Palette um und speichern Sie diese.

• 4. Diagram Designer bietet viele Textformatierungsmöglichkeiten (einschliesslich
höher- und tieferstellen) an. Indem man Text in eine Metadatei umwandelt, kann er
gedreht werden oder die Grösse neu bestimmt werden.

• 5. Projekte können kundenspezifische Seitengrössen annehmen oder der Diagram
Designer kann die Seitengrösse anhand der Druckereinstellung bestimmen. Drucken
Sie das Projekt auf Ihrem Drucker oder speichern Sie es in einer Vielzahl von Vektor-
oder Rasterformaten.



Wie in den Anmerkungen oben gezeigt, passt fGIS das Rasterbild auf die Seitengrösse des
Diagram Designers an. Das Bild wird auf die globale Schablone gesetzt. Sie müssen die
globale Schablone (Diagramm>Ebene bearbeiten>Globale Schablone) aktivieren, um
das Bild zu verschieben oder die Grösse neu festzulegen. Gehen Sie zurück zu den Ebenen
1, 2 oder 3, um Texte und Symbole hinzuzufügen oder zu ändern. (indem Sie
unterschiedliche Objekte auf unterschiedlichen Ebenen halten, können Sie sie ändern ohne
die anderen Objekte auf den anderen Ebenen zu verändern.)
Wenn Sie alle vier Ebenen gleichzeitig sehen möchten, müssen Sie den Befehl
Datei>Bilderschau benutzen. Andernfalls ist nur die globale Schablone und die
gegenwärtige aktive Ebene sichtbar.



Vorgehensweise für den Druck einer Wisconsin MFL-Karte

1. Zoomen Sie in fGIS in den Bereich, den Sie
beabsichtigen zu drucken.
2. Aktivieren Sie nur die Layer, die Sie drucken
möchten.

3. Klicken Sie das Rasterbild-Export-Werkzeug an.

4. Bestimmen Sie den Bereich, den Sie drucken
möchten (ziehen Sie einen Kasten von links oben nach
rechts unten mit niedergedrückter linker Maustaste.
Lassen Sie die linke Maustaste los, nachdem der
Bereich komplett ist).

5. Dieses Dialogfeld öffnet sich, erhöhen Sie die Bildauflösung auf 2. Weniger als 2 erzeugt
gezackte Linien im Kartenbild.

6. Geben Sie Bildnamen und Projektnamen an und klicken Sie auf Export.

7. Sie sehen das exportierte Bild im Diagram Designer, aber es ist zu klein. Um die Grösse
und die Position des Bildes zu ändern, müssen Sie die globale Schablone aktivieren. Wählen
Sie diese Ebene über Diagramm>Ebene bearbeiten>Globale Schablone aus.



8. Ändern Sie das Zoomniveau im Diagram Designer auf 50%, Sie können nun die
vollständige Seite sehen.

Klicken Sie das Auswahlwerkzeug an. Mit der linken Maustaste klicken Sie auf das Bild,
um es auszuwählen und mit der rechten Maustaste wählen Sie die Eigenschaften.

Ändern Sie im Eigenschaften-Dialog Breite und Höhe auf Werte, die Sie möchten.

9. Verwenden Sie den Befehl Diagramm>Ebene bearbeiten>Ebene 1, um die Ebene 1
zu bearbeiten.
Ziehen Sie Nordpfeil und andere Symbole auf den Kartenbereich. Diese Objekte können in
der Grösse angepasst und gedreht werden, indem man an den Handgriffen der
ausgewählten Objekte zieht oder indem man mit Rechtsklicken der Maustaste die
Eigenschaften ändert.

10. Vergrössern Sie die MFL-Kartenüberschrift und klicken Sie mit der linken Maustaste auf
den Text, den Sie ändern möchten. Drücken Sie F2, um den Text zu bearbeiten:



Das erste Teil der Textfolge ist der Formatierungscode. Im oben genannten Beispiel wird die
Schriftart wie folgt eingestellt: fett, 12 Punkt (\B\12). Wenn Sie keine Schriftart
spezifizieren, wird Arial 10 Punkt genommen. Der Inhalt des Textes folgt nach einem
Leerschlag. Klicken Sie auf OK um die Änderungen anzunehmen.

11. Sobald alles positioniert ist und der Text korrekt ist, verwenden Sie Datei>Drucken
um die Karte zu drucken. Speichern Sie danach das Projekt.

Bemerkung: Die Kartenüberschrift ist in der Datei MFL_header_only.ddd gespeichert.
Ändern Sie diese Datei entsprechend Ihren Anforderungen, damit die Überschrift so
erscheint, wie Sie es möchten.



  

fGIS Flächen verschneiden

Inhaltsverzeichnis:
A. Aufspalten von Flächen mit dem Zerteilen-Werkzeug
B. Anfügen von Flächen mit dem Subtrahieren-Befehl
C. Erzeugen und Entfernen von Öffnungen in Flächen
D. Einpassen von Flächen mit dem Ausschneiden-Befehl
E. Einpassen von Flächen, die innerhalb anderer Flächen liegen

A. Aufspalten von Flächen mit dem Zerteilen-Werkzeug

Das Zerteilen-Werkzeug  wird benutzt, um vorhandene Flächen in kleinere Flächen
aufzuspalten.
Im folgenden Beispiel wird die grüne Fläche, welche mit "PR" beschriftet ist, mit dem
Zerteilen-Werkzeug in zwei Flächen aufgespaltet.

Die grüne Fläche, welche mit "PR" beschriftet ist, wird mit dem Zerteilen-
Werkzeug aufgespaltet.

1. Wählen Sie Editor>Bearbeitung starten um die Fläche zu bearbeiten.

2. Klicken Sie auf das Zerteilen-Werkzeug .
3. Digitalisieren Sie die Linie mit der die Fläche geteilt werden soll. Beginnen Sie

ausserhalb der Fläche und beenden Sie die Linie auch ausserhalb der Fläche, wie
unten gezeigt.



Um eine Fläche aufzuspalten, muss die Teilungslinie ausserhalb der Fläche
beginnen und enden.

4. Doppelklicken Sie, um die Teilungslinie zu beenden und die Fläche in zwei Flächen
aufzuspalten.

5. Das Resultat des Aufspaltens der Fläche mit dem Zerteilen-Werkzeug wird unten
gezeigt. Beachten Sie wie die Attribute der ursprünglichen Fläche auf die neue Fläche
übertragen werden und die Beschriftung automatisch aktualisiert wird.

Das Resultat des Aufspaltens einer Fläche mit dem Zerteilen-Werkzeug.



B. Anfügen von Flächen mit dem Subtrahieren-Befehl

Wenn man Flächen digitalisiert, die nebeneinander liegen, ist es häufig einfacher, eine neue
Fläche mit dem Subtrahieren-Befehl anzufügen, anstatt zu versuchen, die neue Fläche an
die vorhandenen Flächen anzupassen.
Im folgenden Beispiel wird die rote Fläche, mit "A" ist, mit dem Subtrahieren-Befehl an
die angrenzenden Flächen angefügt.

Die rote Fläche, mit "A" beschriftet, wird mit dem Subtrahieren-Befehl an die
angrenzenden Flächen angefügt.

1. Wählen Sie Editor>Bearbeitung starten um die Fläche zu bearbeiten.

2. Mit dem Neuen Objekt-Werkzeug digitalisieren Sie eine neue Fläche, die die
Ränder der grünen und blauen Flächen überschneidet (siehe unten).

Der überlappenden Fläche werden die Flächen subtrahiert.



3. Wählen Sie die überlappende Fläche mit dem Auswahl-Werkzeug aus.
4. Wählen Sie Editor>Flächenfunktionen>Bereich subtrahieren, um die gewählte

Fläche von den überdeckenden Bereichen zu befreien.
5. Das Resultat des Subtrahierens der Fläche mit dem Subtrahieren-Befehl wird

unten gezeigt. Die Grenze der roten Fläche, die "A" beschriftet ist, schmiegt sich
jetzt den Grenzen der angrenzenden Flächen an.

Die Grenze der roten Fläche, welche mit "A" beschriftet ist, verläuft entlang den
angrenzenden Flächen.



C. Erzeugen und Entfernen von Öffnungen in Flächen

Häufig ist es notwendig Öffnungen in Flächen zu erzeugen oder Öffnungen zu entfernen.
Dies wird anhand der grünen Fläche, die mit "PR" beschriftet ist, gezeigt.

Die grüne Fläche, welche mit "PR" beschriftet ist, erhält ein eine Öffnung.

Um eine Öffnung einer Fläche hinzuzufügen, verwenden Sie das folgende Verfahren.
1. Wählen Sie Editor>Bearbeitung starten um die Fläche zu bearbeiten.

2. Wählen Sie die Fläche mit dem Editier-Werkzeug/Auswahl-Werkzeug aus.
Anmerkung: Die Fläche ist ausgewählt, wenn alle Punkte der Fläche numeriert
angezeigt werden.

3. Klicken Sie mit der rechten Maustaste an die Stelle der ausgewählten Fläche wo die
Öffnung hinkommen soll und wählen Sie Editor>Flächenfunktionen>Bereich
hinzufügen.
Anmerkung: Der Befehl Bereich hinzufügen ist nur über die rechte Maustaste,
nicht über das Editor-Menü verfügbar.



Der Befehl "Bereich hinzufügen" wird verwendet um Öffnungen in Flächen zu
bilden.

4. Digitalisieren Sie jetzt die Grenzen der Öffnung.

Anmerkung: Es ist am Besten die Öffnung rechtsherum zu digitalisieren, andernfalls
muss die Fläche mit dem Befehl Flächenfunktionen>Drehsinnkorrektur korrigiert
werden.

5. Um das Digitalisieren der Öffnung zu beenden, doppelklicken Sie mit der Maus oder
wählen Sie Objekt schliessen.

6. Wenn die Öffnung nach der Digitalisierung nicht erscheint, stellen Sie sicher, dass
die Fläche noch ausgewählt ist und wählen Sie
Flächenfunktionen>Drehsinnkorrektur.

Um eine Öffnung aus einer Fläche zu entfernen, verwenden Sie das folgende Verfahren.
1. Wählen Sie Editor>Bearbeitung starten um die Fläche zu bearbeiten.
2. Wählen Sie den Rand der Öffnung mit dem Editier-Werkzeug/Auswahl-

Werkzeug aus.
Anmerkung: Die Öffnung ist ausgewählt, wenn jeder Punkt der Fläche, wie unten
gezeigt, numeriert angezeigt wird.



Die Öffnung in der grünen Fläche, mit "PR" beschriftet, wird ausgewählt und alle
Punkte werden numeriert angezeigt.

3. Sobald die Öffnung ausgewählt worden ist, wählen Sie
Editor>Flächenfunktionen>Bereich löschen, um die Öffnung aus der Fläche zu
entfernen.



D. Einpassen von Flächen mit dem Ausschneiden-Befehl

Wenn man Flächen in Bereichen digitalisiert, in denen Flächen bereits vorhanden sind, ist es
häufig einfacher, eine neue Fläche mit dem Ausschneiden-Befehl einzupassen, anstatt
versuchen sie an vorhandene Fläche anzupassen.
Anmerkung: Der Ausschneiden-Befehl arbeitet nur mit Flächen, die andere Flächen
überschneiden. Ein Fläche, die nur innerhalb einer anderen Fläche liegt, wird wie in Kapitel
E. beschrieben eingepasst.
Im folgenden Beispiel wird die rote Fläche, die mit "A" beschriftet ist, in die angrenzenden
Flächen eingefügt.

Die rote Fläche, die mit "A" beschriftet ist, wird in die angrenzenden Flächen
eingefügt.

1. Wählen Sie Editor>Bearbeitung starten um die Fläche zu bearbeiten.

2. Mit dem Neuen Objekt-Werkzeug digitalisieren Sie ein neue Fläche, die die
grüne, blaue, braune und orange Fläche überdeckt.

3. Wählen Sie mit dem Auswahl-Werkzeug diese Fläche aus.
Anmerkung: Wenn die neue Fläche die anderen Flächen völlig überdeckt (wie sie es
in diesem Beispiel tut), dann verwenden Sie Befehl Layer>Letztes Objekt
auswählen, um die neue Fläche auszuwählen.



Die überlappende Fläche wird in die vorhandenen Flächen eingepasst.

4. Wählen Sie Editor>Flächenfunktionen>Bereich ausschneiden, um die
überlappende Fläche in die vorhandenen Flächen einzupassen.

5. Das Resultat des Ausschneidens wird unten gezeigt. Die Grenze der roten Fläche, die
mit "A" beschriftet ist, passt sich nun den Grenzen der angrenzenden Flächen an.

Die Grenze der roten Fläche, die mit "A" beschriftet ist, passt sich den Grenzen der
angrenzenden Flächen an.



E. Einpassen von Flächen, die innerhalb anderer Flächen liegen

Wie oben erwähnt, kann der Ausschneiden-Befehl NICHT verwendet werden, um Fläche
zu verschneiden, die völlig innerhalb der Grenzen einer anderen Fläche liegen.
Um Flächen zu verschneiden, die völlig innerhalb von anderen Flächen liegen, verwenden
Sie das folgende Verfahren.

1. Erzeugen Sie zuerst eine Öffnung, wie in Kapitel C. beschrieben, in der
zugrundeliegenden Fläche.

Erzeugen Sie zuerst eine Öffnung in der zugrundeliegenden Fläche.

2. Stellen Sie nun die Fang-Option auf den aktuellen Layer, wie unten gezeigt.

Stellen Sie die Fang-Option auf den aktuellen Layer.

3. Dann digitalisieren Sie mit dem Neuen Objekt-Werkzeug eine neue Fläche und
fangen die vorhandenen Punkte der Öffnung, wie unten gezeigt.



Die neue Fläche wird in die Öffnung eingepasst.



  

Finden von Daten für fGIS

Um ein Projekt mit fGIS anzulegen, müssen Sie mindestens einen Layer (z.B. ein
georeferenziertes Luftbild oder eine digitalisierte Karte) laden. Alle Layer in einem Projekt
müssen auf einer konstanten Projektion mit einem Bezugspunkt basieren. So wo erhalten
Sie Daten, um ein Projekt zu beginnen?

Landesvermessungsämter in Deutschland
• Baden-Württemberg

Landesbetrieb Vermessung Baden-Württemberg.
• Bayern

Topografische Karten der Bayerischen Vermessungsverwaltung.
• Berlin/Brandenburg

Landesvermessung und Geobasisinformation Brandenburg.
• Hessen

Geodaten-Warenhaus der hessischen Verwaltung für Kataster und Flurneuordnung.
• Mecklenburg-Vorpommern

Top50 auf CD-ROM beim Landesvermessungsamt Mecklenburg-Vorpommern.
• Niedersachsen/Bremen

Top50 auf CD-ROM beim LGN (Landesvermessung + Geobasisinformation
Niedersachsen).

• Nordrhein-Westfalen
Top50 auf CD-ROM beim Landesvermessungsamt Nordrhein-Westfalen.

• Rheinland-Pfalz/Saarland
CD-ROM-Publikationen des Landesamtes für Vermessung und Geobasisinformation
Rheinland-Pfalz.

• Sachsen
CD-ROM "Top50 Sachsen" beim Landesvermessungsamt Sachsen.

• Sachsen-Anhalt
CD-ROM "Top50 Sachsen-Anhalt" beim Landesamt für Vermessung und
Geoinformation.

• Schleswig-Holstein/Hamburg
CD Top50 Schleswig-Holstein/Hamburg der Vermessungs- und Katasterverwaltung
Schleswig-Holstein.

• Thüringen
Kartenvertrieb des des Thüringer Landesvermessungsamtes.

Stellen in der Schweiz
• Bundesamt für Landestopografie

Stellen in der Österreich
• Bundesamt für Eich- und Vermessungswesen
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Additional copyrights related to fGIS components apply as follows:
-----------------------
SHPTRANS - Shapefile coordinate transformation utility version 1.1c-pre2.
Copyright (c) 1999-2003 Bruce Dodson and others. All rights reserved.
This software is protected by copyright law and is made available
under the following license. The copyright holders do not intend
for these license terms to form a contractual agreement.
SHPTRANS License 1.1:
SHPTRANS is Copyright (c) 1999-2003 Bruce Dodson and others.
All rights reserved.
Permission to use, copy, modify, merge, publish, perform,
distribute, sublicense, and/or sell copies of this original work
of authorship (the "Software") and derivative works thereof, is
hereby granted free of charge to any person obtaining a copy of
the Software, subject to the following conditions:
1. A copy of this license (including the above copyright notice,
this permission notice, and the following disclaimers) must
appear in the documentation or in other materials accompanying
the Software, where an end-user can reasonably be expected to
see it.



2. The above copyright notice must appear in all copies of the
Software and in any portions thereof. The copyright notice
must be followed immediately by a notice stating that the
Software is made available under the terms of this license,
and indicating where the complete license text is found.
3. Products derived from the Software must include the following
notice in their documentation or in other materials accompanying
the work, where an end-user can reasonably be expected to see it:
"Portions of this software are based on SHPTRANS by Bruce Dodson."
4. The names of the copyright holders and contributing authors may
not be used to endorse or promote products derived from the
Software without specific prior written permission.

THE SOFTWARE IS PROVIDED "AS IS" WITHOUT WARRANTY OF ANY KIND.
THE COPYRIGHT HOLDERS AND CONTRIBUTING AUTHORS DISCLAIM ANY AND
ALL WARRANTIES, WHETHER EXPRESSED OR IMPLIED, INCLUDING BUT NOT
LIMITED TO THE IMPLIED WARRANTIES OF MERCHANTABILITY, FITNESS FOR
A PARTICULAR PURPOSE AND NONINFRINGEMENT.
IN NO EVENT SHALL THE COPYRIGHT HOLDERS OR CONTRIBUTING AUTHORS
BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER LIABILITY, HOWEVER
CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN AN ACTION OF
CONTRACT, TORT OR OTHERWISE, ARISING IN ANY WAY OUT OF THE USE
OR DISTRIBUTION OF THE SOFTWARE, EVEN IF ADVISED OF THE
POSSIBILITY OF SUCH DAMAGE.

End of SHPTRANS License
----------------------------------

NTv2 Support:
Support for Canadian NTv2 datum conversion as implemented in SHPTRANS
was originally based on a program called NADCONV, which was published
as part of the Open Geographic Datastore Interface (OGDI) project.
The source code for NADCONV was licensed under the following terms:

Copyright (c) 1996 Her Majesty the Queen in Right of Canada.

Permission to use, copy, modify and distribute this software and
its documentation for any purpose and without fee is hereby
granted, provided that the above copyright notice appear in all
copies, that both the copyright notice and this permission notice
appear in supporting documentation, and that the name of Her
Majesty the Queen in Right of Canada not be used in advertising
or publicity pertaining to distribution of the software without
specific, written prior permission. Her Majesty the Queen in Right
of Canada makes no representations about the suitability of this
software for any purpose. It is provided "as is" without express
or implied warranty.
The original source code for NADCONV has been enhanced in accordance
with those terms. The enhancements are part of SHPTRANS, and are
Copyright (c) 1999-2003 by Bruce Dodson.
In order to exercise rights in SHPTRANS, or in any other work that
incorporates the SHPTRANS implementation of NTv2, you must do so in a
manner that satisfies the conditions of both the NADCONV permission
notice and the SHPTRANS license.
---------------------
See the fGIS System folder for additional information about Diagram Designer and Convert.



  

fGIS Revision History
 
July 12, 2005
1. Incorporated latest TatukGIS DK.
2. New MrSid library, only ttkMrSid4.dll is required for MrSid viewing.
3. Vertices are now displayed for the layer specified in the Snapping combobox, while
editing shapes.
4. JPEG2000 support added.
5. IMG file support added.
6. GML file support added.
7. Bug Fix: The Layer > Export Layer dialog would not add the proper file extension if
exporting to MIF or DXF formats. MIF or DXF formats should now be exported properly.
8. Bug Fix: The join created by the Utilities > Join Access Table to Shapefile dialog was not
being properly saved to the project file.
9. Added "/ini" directory with Ini files created to be used in Wisconsin DNR Managed Forest
Law (MFL) maps.
10. Added "mfl_map_header_icons.doc", a Word map template that includes moveable map
icons.
11. Added "landscape.tpl", a fGIS map template in landscape orientation.
 
June 28, 2005
1. Bug Fix: the Utilities > Join Access Table to Shapefile dialog would only allow the fields
from the first table in the database to be used in the join. Now any field from any table in
the database can be used.
2. Bug Fix: the Layer > Load .ini File command was not loading legend text properly.
3. The default installation directory for "fGIS_setup.exe" has been changed to
"C:\DNRAPPS" to accommodate Wisconsin DNR users. If you prefer another location such as
"Program Files", then type in an alternate folder name in the setup dialog.
4. Updated the Help file to suggest using HyperCube from the US Army Corps of Engineers
for image warping and georeferencing in combination with fGIS.
 
May 10, 2005
1. Added the Utilities > Merge Shapefiles dialog. This dialog can be used to merge
multiple shapefiles into a new one. All fields from all input layers will be included in the
output shapefile.
2. The Map > New Layer command now includes the New Shapefile Field Manager dialog
to retrieve default attribute table settings. These settings are stored in a file named fgis.ini
that is stored in the same directory as fGIS.exe. The New Shapefile Field Manager dialog
can also be accessed from the Utilities > New Shapefile Field Manager command. An
example fGIS.ini file to be used with the New Shapefile Field Manager is included (open it in
Notepad or other text editor).
3. Added the Utilities > Clip Shapefiles dialog. Use this dialog to clip line or polygon
layers to the boundaries of a polygon layer.
Point layers can NOT be clipped using this dialog. To clip out point layers, select the points
using the Map > Spatial Selection dialog, then create a new shapefile of the selected points
using the Layer > Export Layer dialog.
4. Added the Utilities > Repath Project File dialog. This dialog is useful for modifying a
project file after data, projects, or directories have been moved.
5. Added WMF export capability to the Map > Export View to Image dialog. Note that
WMF graphics can only be exported at screen resolution. The vector layers in WMF images
can be resized without loss of quality in drawing programs. WMF images are not



georeferenced.
6. An Access table join (created via the Utilities > Join Access Table to Shapefile dialog) can
be saved to and reloaded from the project file.
7. Addition in the Load Library Layer dialog: When a new Env file is selected with the Env >
Set Env File command and the project is saved, the new Env file name will be saved to a file
named fgis.ini and used as the default Env file.
In the Load Library Layer dialog, layer display names can be specified in a field named
"Alias" in the layer table, however the names stored in a .ini file will take precedence.
8. Added the "Increase Output Feature Size by" functionality to the Map > Send Map to
Word dialog.
9. Bug fix: the Edit > Paste Shape command did not work if there were no other shapes in
the shapefile.
10. The Import XY Table to Shapefile dialog now adds the new shapefile to the view after
creating it.
11. The Map > Print Map dialog now includes a "white legend" checkbox that changes the
Legend to white so that the background of legend icons prints white.
12. Bug fix: The Layer > Load .ini File command would only load the first legend item. Now
it should load all.
13. Added the Minimize Window checkbox to the Search dialog.
14. The Map > Set Default Data Directory command was added. This command will set
the first directory that fGIS look to for data, rather than the fGIS installation directory.
15. Updated language.ini.
 
April 7, 2005
1. Added the Layer > Copy Selected Shape and Edit > Paste Shape commands (also
available from the View's right-mouse-click popup menu) so that shapes can be copied from
other layers to the layer being edited. Line objects can only be pasted into line layers,
polygon objects into area layers, etc. The shape is copied in WKT (Well-Known Text) format
so that users could create or edit a shape in a text editor and paste it directly into the layer.
To see the format, copy the shape and paste into a text editor.

2. Added Chains to status bar when using the Measure tool. (Chains are a standard land
survey measurement. One Chain = 66 feet; 80 Chains = 1 Mile)

3. Added the Map > Bookmarks command. Multiple named bookmarks can be utilized and
saved to the project file.

4. Added all UTM zones to the Lat./Lon. to WTM (Wisconsin Transverse Mercator) form. UTM
users can modify the language.ini to display "UTM" text instead of WTM, or to place their
UTM zone at the top of the projection list. Also added two checkboxes to add "-" signs to
the input coordinates to designate southern and western hemispheres. (Longitude should be
set to negative for users in Wisconsin and elsewhere in the US.)

5. The WTM location to Lat./Lon. command (from the view's right-mouse-click popup menu)
will now utilize whatever projection is selected in the Lat./Lon. to WTM form (WTM or any
UTM zone). Again, UTM users can modify the language.ini to display "UTM" text instead of
WTM, or to place their UTM zone at the top of the projection list.

6. Added the Search for Township/Range/Section dialog to the Utilities menu. Requires that
an appropriate Public Land Survey System layer is loaded.

7. Added the Layer > Load .ini file command. This command enables layer properties saved
to an .ini file to be used for another layer. Users could create a library of .ini files and load
them as new layers are created.

8. Added the Map > Selection submenu. The Selection Color command allows the selection
color to be changed. The Selection Transparency sets the transparency of the selection
color. Both settings are saved to the project file.



9. Updated the Utilities > 3-D Viewing > Export View to 3-D dialog to only output four
standard image widths. The 3-D viewer software does not operate properly unless the input
image width has an even number of pixels. Also, the 3-D viewer software locks-up if the
input image is too large.

10. Updated the Map > Export View to Image command to include a dialog and additional
options. By increasing the output image size, multiple images in the view can be put into a
mosaic. Output image size can also be increased if the view is intended for printing in a
publication. Increasing the output feature size will increase the size of labels, points, and
lines in the output image.

11. The Remove All and Load .ini File buttons were added to the Image Catalog utility.

12. The Import XY Text Table to Shapefile dialog can now convert tab-delimited text tables
to shapefiles.

13. Bug fix: The Traverse dialog was incorrectly computing bearings when a N/S degrees
E/W bearing was input.

14. Modified the Layer > Save Layer Properties to .ini File command to prompt for the .ini
file location. The default location is the location of the layer. This makes it easier to create
libraries of layer.ini files, or to create a layer.ini file for a file in a read-only directory.

15. Bug fix: The Map > Save Project As command would not function if the original project
file was Read-only. This should make it easier to modify projects in Read-only directories or
CDs.

16. Bug fix: The "Increase output feature size" listbox from the Export View to 3-D dialog
wasn't working properly.

17. Created a dialog for the Map > Send Map to Word command.

18. Created a dialog for the Export Image tool.

19. Added the Utilities > Routing Utility: The Routing Utility will locate addresses (using the
From text and the Find Address button) and find the best route between two addresses
(using the Find Route button) in the Routing Layer. The Routing Layer is typically a Road
shapefile based upon the US TIGER roads data. Such a layer is available in the
State_Park.zip fGIS sample dataset and for WI from the DNR. See dialog for more help.

20. Added the ability to select a different env.txt file instead of the one in the /fgis directory
using the Env > Set Env File command on the Load Library Layer dialog. The default env.txt
file can also be set in the language.ini file.

21. The Load Library Layer dialog will now optionally load an .ini file specified in the
INI_FILE field of the Layer Table. This field can use environment variables for the path.

22. Added the Utilities > Live GPS Utility. This utility will display the GPS location for a GPS
receiver outputting NMEA format data connected to the COM port. The location can
optionally be snapped to a line layer to correct for moving features. This utility has not been
tested with moving GPS receivers. See the dialog for more help.

23. There is now a small "C" button on the Lat/Lon Location to WTM dialog that will convert
the input Lat/Lon to/from DD, DM, or DMS.

24. Updated language.ini.
February 24, 2005



1. Reverted back to the previous shape digitizing mode, again by popular demand. When
digitizing, the next vertex is added to the closest line segment, rather than connected to the
previous vertex. Vertices can be added by clicking on a line segment. Vertices can be
deleted by double-clicking on them. Holding down the <SHIFT> key and digitizing will
attach the next vertex to the previous one.

2. Updated the DXF handling library. It should handle complex files better.

3. Changed the Map > Print Simple Map command to Map > Print Map. The new dialog
includes the previous Simple Map as well as a Template Map printing section, page
orientation, and printer setup functions. A template example is included (print.tpl) for
advanced users who want to design their own. The template files can be edited in Notepad.
(Wisconsin DNR foresters will receive additional print template files from the GIS specialist.)

4. The Map > Overview Map command was added. This displays the Overview Map view.
Using the right-mouse-click popup menu on the Overview Map, a layer can be added and
the extent box color can be changed. The extent box can be used to change the extent of
the main map view by left-clicking and dragging in the Overview Map view. The contents of
the Overview Map are also saved to the project file. The Overview Map can also be used in
the template files (.tpl) used with the Map > Print Map command.

5. Added the 3-D Viewing submenu to the Utilities menu. The 3-D Viewing > Export View to
3-D command displays a dialog that will export a DTM to a TIFF and the view to a BMP so
that they can be viewed in a 3-D viewer program. The 3-D Viewing > Launch 3-D Viewer
command will launch the utility. Note: This feature is in a beta stage and may not work
consistently. The 3D viewer (©Geomantics Ltd.) is distributed with Forestry GIS under license to
the Wisconsin Department of Natural Resources - Division of Forestry.
6. Updated the Traverse tool to utilize N S E W directions.
7. Added Miles to the Traverse dialog for fire lookout tower shots.

8. Added the Hyperlink tool to the Utilities menu. This tool changes the function of the Pick
tool to display the file specified by the filename in the Hyperlink field for the shape selected.
Images, text documents, web pages, etc. can be used.

9. Bug fix: the quarter-quarter description generated by the Lat./Lon. Location to WTM
dialog was reversed.

10. Changed the Measure tool graphic to Red.

11. The Measure tool now displays the distance from the beginning of the measured line to
the cursor location.

12. Updated language.ini.
January 27, 2005

1. The default digitizing mode has changed. The more intuitive "follow" mode is now
available without having to hold down the shift key.  If you hold down the shift key
when digitizing, the next vertex will be inserted into the nearest line or polygon
segment.

2. The Hide command was added to the Layer menu and the Legend popup menu.  This
will merely hide the layer from the legend so that it does not take up so much space
(for multiple base images, etc.). This setting is saved to the project file.

3. The Unhide All Layers command was added to the Map menu.
4. All image layers are added to the bottom of the layer stack.
5. Right-mouse clicking on the legend now selects the layer under the mouse cursor,

and then displays the popup menu.
6. The display coordinates on the lower status bar display more decimal places if

decimal degree data are being used.
7. The status bar turns red when editing a shapefile.



8. New splash screen in About box.
9. By popular demand, the legend remains enabled when a shapefile is being edited.
10. Added Help box for the Traverse dialog.
11. The Add Point button on the Traverse dialog will now add a new point to a point

shapefile relative to the point currently selected with the Edit Points tool (i.e., the
Traverse Tool now works for point, line and polygon objects).

12. Added support for ESRI Grid files (*.adf). This is the DEM format used by Wisconsin
DNR.  These can be colored nicely using the Wizard button on the Layer Properties
dialog.

13. Projects should load faster, because the view goes directly to the saved extent,
rather than the full extent first.

14. The Image Catalog Utility dialog (Utilities > Image Catalog Utility) will load all layers
in an image catalog and optionally hide them all upon loading. The DNR uses image
catalogs to load groups of DRGs. There are also commands to Turn On/Off and
Hide/Unhide all image layers as a group.

15. Rods and Chains have been added to the Traverse window.
16. DMS added to Lat/Lon Location to WTM dialog.
17. The Sort Shapefile button was added to the Join Access Table to Shapefile dialog. 

a. This function will sort the selected shapefile by the selected attribute field and
output it to a new shapefile. The new, sorted shapefile should be added to the
theme (legend or table of contents) in order to take advantage of it for the
Access table join in (b).

b. Access table records are now sorted by the join field prior to creating the
join.  The join works best if there is a one-to-one relationship between the
records in the shapefile and the Access table, AND if the records in each
dataset are sorted by the same field.

18. "Table > Add Field" and "Field > Delete" commands were added to the Shapefile
Table dialog. (You can also add or delete attribute table fields with the Attributes
Tool while in the Edit mode.)

19. Updated the language.ini file.
January 12, 2005

1. Added the utility "Import XY Text Table to Shapefile". This command will create a
point shapefile from a comma delimited text table with XY coordinates in decimal
degree format.

2. Added the utility "Join Access Table to Shapefile". The Join is a "live" join to the
database. The joined fields are visible in the Layer Properties, Attributes Tool, and
Search dialogs.

3. The fGIS help is now in CHM format rather than HTML.
4. Bug fix: If a layer was removed from the view and there was no selected layer in the

legend/table of contents, an error occurred when the user right-mouse clicked in the
view.

5. Measure Tool dialog box text corrected for "Length".
6. The Lat/Lon Location to WTM dialog is now minimized before it places a graphic dot

on the view so that it does not completely cover the graphic dot.
7. Updated the language.ini file.

January 2, 2005
1. Updated the Help System for revisions made to date. (FYI: Significant

additions/changes to fGIS are anticipated in the first quarter of 2005. Plans include
simplified print layout and 3D viewing capabilities among other features under
development.)

 
Oct. 2, 2003 - Initial beta release.


